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THE OFFICIAL
MAGAZINE

he whole point of the Raspberry Pi is that

you can muck it up and start again. That’s

what makes it an amazing computer for
digital makers, coders, and hackers.

Being able to fix things is a vital skill for any
computer buff, and you’ll get lots of practise when
using a Raspberry Pi. That’s why we think you’1l
love this month’s Raspberry Pi Troubleshooting
Special (page 16). We wanted a troubleshooting
guide for our workshop, and we thought you might
like a copy in yours.

Digital makers are a pretty creative bunch, and
there’s a thin line between creative projects and
artworks. Over the years, we’ve encountered many
projects that verge on genius.

There’s a lot to be said for making art with a
Raspberry Pi, and we’ve got a lot to say on the
subject this month in our Get Creative feature
(page 67). If you’re a digital artist looking to
pick up some new skills, we’ll show you how to
integrate video, sound, light, and motion into
your creations. It’s a great tutorial if you’re not
an artist - in fact, especially if you’re not an
artist - as there are plenty of practical skills and
tricks on show.

Whether you’re fixing a technical hole in your
project, or reaching for the creative stars, there’s
something for you in this issue.
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Editor - The MagPi
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Y[/l NEW RASPBIAN

NEW VERSION
OF RASPBIAN

WITH SCRATCH 2.0 AND THONNY

Raspbian update has the latest version of visual programming
without the network requirement

recent update to Raspbian
has added an offline
version of Scratch 2.0.
Previously, only Scratch 1.4 was
available offline, while Scratch 2.0
required an internet connection.
The update means less hassle
and cost for Code Clubs and
CoderDojos, as well as anyone
using Scratch at home.
Simon Long, UX engineer for
Raspbian, says: “Scratch is one

6 | MdgPi August 2017

of the most popular pieces of
software on the Raspberry Pi”, so
the need to bring the latest version
to Raspbian was clear. However,
the latest version available from
Scratch runs in Adobe Flash, which
isn’t supported by Raspbian.
Previously, Simon and the
Raspberry Pi team “worked with
Adobe to include the Pepper Flash
plug-in in Raspbian”, but that only
enabled Scratch 2.0 to run online
in the Chromium web browser.
The need for a Pi to be online to
use Scratch 2.0 excludes many
possible Code Club and CoderDojo
venues, as well as adding the cost

and time of setting up the wireless
connection on each Raspberry Pi.

For this update, Simon made
use of the Electron framework
(electron.atom.io). Electron is
used to provide an environment
in which a local copy of the
Scratch 2.0 editor webpage can
run as a standalone application.

Scratch 2.0 offers several new
features. The Raspbian version also
includes GPIO blocks, enabling easy
access to the GPIO - see our tutorial,
Discover Scratch 2.0, on page 40.

To install Scratch 2.0, open a
Terminal and enter sudo apt-get
install scratch2.

raspberrypi.org/magpi



Introducing Thonny
There’s also a new Python IDE to
help develop your coding skills
beyond visual programming. As
Simon puts it, “It’s fair to say that
IDLE, the Python IDE, isn’t the
most popular piece of software
ever written.”

Simon assessed “20 or 30 IDEs
in total over the course of 3-4
days,” against a set of criteria.
The chosen IDE would have to be
easier for beginners, but still useful
for experienced Python coders.
He “didn’t want to eliminate
something based on an out-of-date
description, only to find later that

it was just what we wanted,” so he
downloaded every IDE onto a Pi and
tested each one.

What was the process like?
Simon replies, “In a word, terrible.

NEW RASPBIAN

Tartu, Estonia. However, Aivar
used Tkinter, Python’s default
GUI toolkit, so Simon worked with
Aivar to make a version that has a
visual style more in keeping with

Scratch 1s one of the most
popular pieces of software
on the Raspberry P1

That’s a week of my life  am never
getting back!”

Thonny was written by Aivar
Annamaa, at the University of

the GTK styling of Raspbian.

To install Thonny, open a Terminal
window and enter sudo apt-get
install python3-thonny.

MOVING TO SCRATCH 2.0

Scratch 2.0 makes it easier to use
the GPIO pins on the Pi. This image
shows the Scratch code for a
flashing LED in Scratch 1.4: terms
such as ‘broadcast’ and ‘config2out’
are hardly intuitive.

raspberrypi.org/magpi

To enable GPIO coding blocks, click
on ‘more blocks' and then add the

Pi GPIO extension. You can now
construct code more easily, with
fewer blocks, and using terms that
are easy to understand.

Scratch 2.0
introduces
‘custom blocks'
which can be
used to define a
function - a set
of actions that
can be used

in a project,
potentially
many times.
This example
shows a
custom block
that makes a
sprite jump.

News

Above left The new
version of Scratch
runs offline, and
also makes physical
computing easier

Above Thonny is the
new Python IDE of
choice for Raspbian
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News

Below Safety rules
exist for a reason,
but with so many
variations, product
certification can be
a headache

INTEGRATOR PROGRAMME

RASPBERRY PI

INTEGRATOR
PROGRAMME

Quicker, easier and cheaper certification of your Pi-based product

he Raspberry Pi Foundation

has launched the Raspberry

Pi Integrator Programme to
“help anyone get their Raspberry
Pi-based product tested and on the
market quickly and efficiently,”
says Roger Thornton, Principal
Hardware Engineer.

a way that it might overheat?
Does the casing of the product
use safe, non-toxic, non-
flammable materials?

However, “different countries
usually have slightly different
sets of regulations, and testing
has to be conducted at an

uses for its certification process, UL
Certification (ul-certification.com).
“We have put the Integrator
Programme in place in the hope
of eliminating the burden of
navigating complicated compliance
issues,” Roger said. “With
simplified testing, companies

With simplified testing, companies and
individuals can get products to market
1In less time and with lower overhead costs

Before a new product goes on
sale, “it first has to prove that
selling it is safe and legal.” It is
not sufficient to say that the Pi
has been proved safe and legal,
as there is more to a Pi-based
product than just the Pi. For
example, is the power supply
safe? Is the Pi packaged in such

MégPi August 2017

accredited facility for the region,”
Roger explains. The regulatory
compliance process can be lengthy,
costly, complex, and “especially
taxing for smaller enterprises.”
The Integrator Programme aims to
cut through this burden by offering
access to the same test engineers
that the Raspberry Pi Foundation

and individuals can get products to
market in less time and with lower
overhead costs.”

Furthermore, “our Integrator
Programme is openly available,”
Roger confirms. “It comes with
no added cost beyond the usual
testing fees at UL.” With UL’s
experience dealing with the
Raspberry Pi hardware, you’re
already one step ahead of any other
compliance company.

The Integrator
Programme is accepting
new clients already. Email
compliance@raspberrypi.org
with details of your Pi-based
product. Don’t forget about
the Powered by Raspberry Pi
programme, which shows
customers that your product
supports the Raspberry Pi
Foundation’s educational work via
the use of a dedicated logo. See
magpi.cc/2smAAzN for details.

raspberrypi.org/magpi



raspberrypiorg/magpi August 2017 MdigPi



/IZT//l MACROBERT AWARD / Pl SIMULATOR
RASPBERRY Pl WINS

Prestigious engineering prize awarded for ‘sheer quality’

s one of three finalists announced last
A month, the Raspberry Pi has won the ‘most
prestigious national prize for engineering
innovation’, the Royal Academy of Engineering’s
MacRobert Award.

The Chair of the MacRobert judging panel, Dr
Dame Sue Ion DBE FREng FRS; said, “What sets the
Raspberry Pi apart is the sheer quality of innovation,
which has allowed the computer to be used far beyond
its original purpose.”

The MacRobert Award is judged on three criteria:
‘outstanding innovation, tangible societal benefit, and
proven commercial success.” With sales of more than
13 million units, the “Raspberry Pi’s original educational
goal has actually resulted in a computer control system
that can influence many different industries,” according
to Sue, while “communities in the developing world are
being empowered by the Raspberry Pi.”

Raspberry Pi co-founder Eben Upton says that
winning the MacRobert Award “represents fantastic
The MacRobert Award was accepted recognition for the ongoing work of Raspberry
on behalf of the entire Raspberry Pi Pi, Code Club, CoderDojo, and the whole STEM
Foundation and community education ecosystem.”

MICROSOFT BUILDS
RASPBERRY PI

SIMULATOR

New online service could help with
prototyping your next Raspberry Pi project

icrosoft has created an online Raspberry Pi simulator. We can look forward to a “drag-and-drop
simulator to help Pi users prototype new experience on the left area” to add other elements
builds. The simulator uses Microsoft’s Azure to a simulated Pi build. However, as the whole
platform to create and host a virtual Pi. project is open source, you could create your own
The service is still in its early stages. As Microsoft’s  electronics (magpi.cc/2tdityO).
Xin Shi explained via GitHub’s Gitter chat service, Setting up the Pi simulator is a little convoluted.
“actually now the device and sensors on the left side You’ll need an Azure account (which is free for
is a static image.” hobbyists), followed by a 13-step process just to
There are plans to incorporate the ability to run the basic simulation. Thankfully, Microsoft
add other sensors, inputs, and outputs to the documents the process clearly at magpi.cc/2ulWcNM.

10 | MdgPi August 2017 raspberrypi.org/magpi




FOR THE

UBUNTU

ORE

COMPUTE
MODULE

Bespoke IoT operating system
makes deployment and security easy

buntu Core, Canonical’s
dedicated IoT operating
system, is now available for
the Raspberry Pi Compute Module 3
(CM3). Installing Core on CM3 is
an “easy, cost-efficient route to
the production of fully featured
devices ... while benefiting from
the additional security of Ubuntu
Core,” according to Canonical.
Mike Bell, Canonical’s EVP
of Devices and 10T, added,
“With CM3, the development
of everything from an edge
router, to a smart lift, to a next-
generation vending machine or

digital signage solution ... is now
as easy as developing a custom
snap.” A ‘snap’ is a ‘universal
Linux package for an app and all its
dependencies’.

Core was previously available
for the Raspberry Pi 2 and 3,
but a Canonical spokesperson
revealed to us that as “U-boot
does not support CM3 out of the
box,” changes were needed in
the boot stack order to achieve
CM3 compatibility. You can build
your own CM3-based Ubuntu
Core device by following the guide
at magpi.cc/2smgBkM.

Above Ubuntu Core can handle security and updates for Pi-based loT devices

raspberrypi.org/magpi

News

NOW TRENDING

The stories we shared that
flew around the world

FREE CAMERA
MODULE GUIDE

magpi.cc/2rJNsQ5

UBUNTU CORE

Our comprehensive guide to the
Raspberry Pi Camera Module
covers everything from installing
the module to building exciting
camera-based projects. Discover
how to build a spy camera or
produce live-streaming video.

. NEW GOPIGO 3 ROBOT KIT

magpi.cc/2uGKLjb

Dexter's “totally redesigned” robot kit is “a lot more
robust so you can daisy-chain and add on easily.” The
kit supports DexterOS, which is "designed specifically
for learning how to program robots intuitively.”

. PI-BASED ENERGY MONITOR

magpi.cc/2tB2ufw

Welsh energy-monitoring specialist
OpenEnergyMonitor (openenergymonitor.org) has
announced a smart energy monitor that hooks into
its Pi-based smart meter, the emonPi. Based on a
NeoPixel ring and open-source technology,

the emonPixel should be on sale soon.

August 2017



/T/' I8 3 COLOUR EINK HAT

FIRST
THREE-COLOUR

EINK HAT

Pimoroni Inky pHAT packs a ViSLlal pUHCh imoroni has launched the first ever colour
i elnk HAT for the Raspberry Pi. The 2.13-inch
without the power draw screen can display red, white and black and

costs £22 from magpi.cc/2sIRNCE.

While the Inky pHAT offers zero power draw
(spiking to 8 mA when the image changes), and
readability under bright light, screen refreshes can
take up to 15 seconds. That’s still fine for a to-do list,
calendar or similar project.

The Inky pHAT is a 60x30mm Pi Zero-sized HAT, but
“you’ll see a full range of screens, and the upcoming
breakout board which is more suitable for custom
projects,” says Pimoroni Co-founder Paul Beech. “The
sizes go from ‘large stamp’ to ‘small book’ size.”

Colour elnk screens with yellow and blue have been
around for a while, and Paul tells us, “other colours
have been whispered about.” However, he adds, “We
think red was the obvious choice because it stands out
in a retail setting.”

RASPBERRY PI 3 VOTE
‘MOST DESIRABLE'

Hackers rank Raspberry Pi the most inuxGizmos.com and Linux.com’s 2017
g _ Hacker Survey resulted in a huge win for the
popular Slngle board ComPUter Raspberry Pi 3, with a score of 2,583 points.
~ Right The most The second-placed Pi Zero W scored 648.
'rgf ggﬁ&:ﬁgggj A Raspberry Pi of some form has won every Hacker
computer for Survey since the first, in 2014. LinuxGizmos editor
hackers and . « . . s
o ey Eric Brown tells us, “The huge margin of this year’s

victory was surprising. One reason may be that the
Raspberry Pi 3 is the most competitive Pi yet.”

“Also, community counts,” Eric adds. “As the Pi
community’s membership balloons, you can find
answers to your questions more easily than ever ...
Our survey respondents’ top two buying criteria are
open software support and community.”

Eric acknowledges that “if you base a hardware or
software product around the Pi ... you can reduce the
friction in everything from providing accessories to
hiring knowledgeable developers.”

12 | MigPi August 2017 raspberrypi.org/magpi



VISUAL
STUDIO

CODEON
RASPBIAN

Visual Studio for Raspberry Pi updated

obbyist Jay Rodgers, better known online

as ‘headmelted’, has overhauled his Visual

Studio Code application for Raspbian and
Chrome OS. The new build scripts ensure VS Code
will be regularly updated, and with “the absolute
minimum set of patches.”

Asked why he wanted to bring VS Code to the
Raspberry Pi, Jay tells us, “Tools like Vim or Emacs are
not exactly targeted towards beginners (great as they
are!).” Microsoft describes VS Code as “lightweight but
powerful” and offers video guides to help get started
(see magpi.cc/2smkW?7j).

Jay adds that the overhaul was particularly timely, as
“the developer community over the past year has really
rallied around VS Code, and I don’t want those folks on
Raspbian to be neglected.”

While anyone could use Electron to build a VS Code
app, “there are a couple of catches with this,” according
to Jay, “among them that VS Code can take some time to
build ... and doing so is fraught with dependencies that
are not usually present on Raspbian.”

Jay’s application installs via a single command (see
magpi.cc/2tdEnsg), and also allows updates “that are
broadly up to date with the VS Code Insiders release.”

The developer community should “meet new users
where they are,” Jay urges, whether that’s on a Pior a
Chromebook, and that means “making the best tools
available as widely as we can.”

Above Jay often works on coding projects with his son
Benjamin (4, right). Zachary (1, centre) is still a little young

raspberrypi.org/magpi

VISUAL STUDIO CODE  [VIZT7%]

Above VS Code supports many programming languages in a user-friendly environment

August 2017 MdigPi
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Is your Pi having problems? Troubleshoot it with our handy guide!

e el N B

16 | MdgPi August 2017

hether you’re new to the world of

Raspberry Pis, or you’ve been using them

since they launched, there’s always a
moment when something doesn’t quite work the
way you want it to. This may be due to human
error, or to a bug or software quirk that you will
need to work around.

The Raspberry Pi and Raspbian are pretty
reliable, so you shouldn’t regularly encounter
problems unless you’re trying to do something
really complicated. When you do find a problem,
however, here’s some guidance on what you can
do to fix it.

raspberrypi.org/magpi



RASPBERRY Pl PROBLEMS SOLVED

PI PROBLEMS

|

FLOWCHART
T

Does your
Raspberry Pi
turn on?

Is it an issue

AR:’e yobu "e";_t;’ with a piece —)— NO
aspberry Fi: of hardware?

Isita
networking for
problem? Software
Fixes

P24

for

Simple Networking
Issues
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QUICK FIXES

New to Raspberry Pi and having problems? Here's the stuff you need to know.

veryone has experienced being new to The Ra Spb e I'I'Y P].
something! We’ve seen even the most

amazing tech whizzes stumble over ]. S p fOb ably ﬁﬂ e

simple things with the Raspberry Pi, so don’t get

embarrassed or frustrated if you flip the power Your first instinct may be that you’ve done everything
switch for the first time and nothing happens. Stay correctly, so the Raspberry Pi must be at fault. We
calm, and read through the next couple of pages. completely understand that reaction. However, each

Raspberry Pi is tested once it leaves the production
line. It definitely worked before it left the factory, and
the chances of it turning up dead on arrival (DOA) are
very slim.

Of course, in the unlikely case that you’ve
gone through this entire article and come to the
conclusion that your Raspberry Pi is faulty, contact
the place you bought it from and they should be able
to help you.

Essential accessories

We’ve all done it: forgotten, or just missed the

fact that our new gadget needed something else

to go with it — like batteries for the toy you got at
Christmas. You’ll need two things to make sure your

Raspberry Pi is working. The main one is a microSD
card, which you need to load with an operating
system (more details over the page). You will also
need a monitor or TV to connect to the Pi via an
HDMI cable, and a keyboard and mouse to

use it properly.

Reusing SD cards

You’ve taken the SD card from an old Raspberry

Pi that you haven’t used for a couple of years and
plugged it into a brand-spanking new Pi Zero W. [s it
having trouble booting? It’s more than likely you’ll
need to use a fresh SD card in your new computer. If
you’ve forgotten how to install an SD card, look across
the page for our quick guide.

18 | MdgPi August 2017 raspberrypi.org/magpi
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These should always be your
first steps when troubleshooting

TO CHECK

Check all the connections
This may seem obvious, but it’s always worth
wiggling a few cables. You should pay close attention
to the SD card: make sure it’s pushed all the way in
on a Raspberry Pi Zero or Pi 3, and properly clicked
into place in an A+, B+, or Pi 2. The HDMI cable
should also be checked at both ends.

Check the power

Are you using the correct power supply? Are you
plugging it into the correct port on a Pi Zero? For a
Raspberry Pi 3, a 2.5 A power supply is recommended,
while other models can use the same, or a 2 A supply.
Check that the power supply works on another device
before giving up on your Pi.

Faulty OS

It’s possible that the operating system wasn’t installed
properly on the SD card. The Pi might not boot up
properly, or you might see a black screen when you turn
iton. The green ACT LED near the power supply input
(PWR IN) will blink rapidly if it is able to read the card.
If reinstalling doesn’t fix the problem, try downloading
NOOBS or the OS image again. The OS can sometimes
be corrupted during downloading.

Check the monitor

Just double-check it is turned on and set to the correct
input. We’ve all been there — no judgement here.

Best installing practices

NOOBS

New Out Of the Box Software, or
NOORBS, is a series of files designed to
be saved on a blank SD card. Download

the zip file to the card and extract
everything. This makes sure that all the
files you need on the SD card are there.
Delete the original zip file, and put the
card into your Raspberry Pi.

raspberrypi.org/magpi

Problem
still not solved?

Turn the page for
Advanced Boot
Troubleshooting

1

ETCHER

When installing

Raspbian or any

other OS on its

own, you can

always write the

image directly to

the SD card. Etcher is the best app for this, and we have an
excellent video on how to use it here: magpi.cc/2sj7leN.

August 2017 MagPi | 13



BOOT PROBLEMS

Raspberry Pi not turning on? Here are some things to look out for...

20

ou could use a Raspberry Pi for years and not

have any problems — until one day you can’t

turn it on, or it won’t boot properly. There
are plenty of reasons why this might happen, some
of which we’ve talked about on the previous page.
For more advanced problems, here are some tips and
tricks to get your Pi powered up again.

Check the ACT LED

There’s a green LED on the corner near the power
supply input that blinks when the SD card is being
accessed. It’s labelled ACT, and it can be used to
determine whether or not the SD card can be read.

The LED should blink erratically when reading from the
card during the boot process. If it’s not blinking when
the Pi is switched on, it means the card cannot be read.

Waiting on a blown fuse

If no power is being delivered to the Raspberry Pi and
the fault isn’t with the power supply, the polyfuse
(resettable fuse) on the Pi may have blown - note

that there isn’t one on the Pi Zero. Unfortunately,

the only solution to this is to wait a few days for it to
reset. Trying to turn it on before it has recovered will
probably blow the fuse again and reset the wait period.

Not enough power

The power LED will not light up if the voltage from the
power supply drops below 4.65 volts. Check the power
supply and replace it if you need a higher voltage.

MdgPi August 2017

Analogue video

The Raspberry Pi A+, B+, 2, and 3 can output an
analogue composite video signal through the
headphone jack. If it’s your first time using this
feature, make sure your cable works (see page 23).

If you’re using NOOBS;, you can force it to change the
video output during the first ten seconds of booting
by pressing 3 for PAL/UK output, and 4 for NTSC
video output.

Changing video outputs in NOOBS
NOOBS has four different video output options

that you can change during the first ten seconds of
booting. 1 is a normal HDMI output, 2 is safe HDMI,

3 is PAL composite, and 4 is NTSC composite. If you
don’t have a keyboard on the Pi, you can edit the
recovery.cmdline file on the SD card from another
computer and add display=X, where X is one of the
listed options.

Updating an old card

Not all old Raspbian SD cards will work on newer
Raspberry Pis, but you can try updating the OS using
the older Raspberry Pi, then transfer the card to the
new model. You can do this in the Terminal with:

update
upgrade

dist-upgrade
install raspberrypi-ui-mods

raspberrypi.org/magpi
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CORRUPT CARD
CorreCtlY format the SD card Your Raspberry Pi's problem may not be with the
Make sure the SD card is completely formatted software, but with the hardware: your SD card might be
(not just a quick format), especially if you’re corrupt. This can happen for many reasons, but the two

using NOOBS. Remember, it should be formatted most common causes are turning the Pi off repeatedly
as FAT32. without running a proper shutdown, or writing a
lot of data to the card. The latter you'll only really
experience in something like a server setup after a few

Other SD card issues years. The former can be avoided by using shutdown
SD cards don’t last forever, so if a card is not scripts, or using an OS that loads itself directly into
working in your Pi, or on any other system, you may the memory. Try piCore, a version of Tiny Core Linux:

need to use a new SD card. Refer to the ‘Making magpi.cc/2ueA7UL
backups’ boxout to see how to prepare for that
eventuality. You should also make sure the SD
card is properly connected to the pins in the slot
on the Raspberry Pi — it can’t be read it if it’s not
connected properly!

Pi1 Zero NOOBS

The Raspberry Pi Zero is only compatible with

NOOBS 1.5 or later, while the Pi Zero W requires

NOOBS 2.4 or later. Always make sure you download MAKING BACKUPS

the latest copy of NOOBS. Are you still unable to figure out how to boot up your
Raspberry Pi? Are you sure it is a problem with the SD
card? It pays to have a system for backing up your card

Pi Zero workaround so you can make a new one when you need to. You
Can’t write over an old SD card? You can still try can use Win32 Disk Imager to make a copy or clone
using it with the Pi Zero, but first you’ll need to of your card, which you can then write to a different

open a Terminal using a Pi that can read the card, SD card. Check out our video on creating backups:
and run sudo rpi-update. This will update the magpi.cc/MagPiYT.

firmware and should set it up to work with the
Pi Zero.

Light codes and
advanced troubleshooting

Earlier we talked about the ACT LED. It doesn’t just
show whether the SD card is being read - it may also
output a pattern that looks like Morse code. These
coded patterns will let you know about specific
issues with the boot card. Check the additional
information section of this forum post to find out
what each code means: magpi.cc/2sPVvZWZ.
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Solving common Raspberry Pi problems

ometimes, the Raspberry Pi doesn’t work as

you expect it to. The GPIO ports don’t quite do

what you are expecting, or a USB hard drive
doesn’t connect when you want it to. Here are some
of the more common issues that users encounter on
their Raspberry Pi journey.

Rainbows and lightning bolts
Seeing a rainbow block or lightning bolt in the top right-
hand corner of your screen? This is the Raspberry Pi’s
way of telling you that it doesn’t have enough power.
Make sure your power supply can provide 2.5 A for a
Raspberry Pi 3 and 2 A for any other Raspberry Pi model.

Components won't

react to GPIO signals

The Raspberry Pi’s GPIO pins output either o V or
3.3V, providing a digital on/off signal. This is enough
for most uses, but some components (LCDs, UARTS,
and some NeoPixels) require a 5 V output. Most
tutorials will let you know if this is going to be a
problem, and help you to solve it. If not, you’ll need
to use a level-shifter chip in your circuit, such as the
74AHCT125 (magpi.cc/2u9paTV).
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USB and Ethernet
not working on a Model B+

If a keyboard or mouse doesn’t work on a Raspberry
Pi B+, and neither does a wired internet connection, it
may be because you’re using an old version of NOOBS.
Make sure you download the latest version, or use
version 1.3.8 or later.

SD card backup not working

This usually occurs when you’re trying to back up a
card to another SD card of the same size, or smaller.
Between cards that claim to be the same size, there
will be slight variations that may cause problems. The
best solution is to back up to a bigger card, or if you’re
handy with Linux, use GParted to shrink the main
partition on the original SD card.

Lack of SD card space
after an install

This will sometimes happen when you install the OS with
NOOBS, but it’s easy to fix. Go to Menu > Preferences

> Raspberry Pi Configuration and choose Expand root
partition to fill SD card. You’ll need to reboot, but you
should then have access to all your available space.

64+ GB SD card not working

The Raspberry Pi only recognises FAT32-formatted SD
cards. Some formatting software for larger SD cards
will use a different format (exFAT) that the Pi cannot
recognise. You may need to change the partition to
FAT32, and that can be done via Windows using this
software: magpi.cc/2uaRYMz1.

raspberrypi.org/magpi
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Raspberry Pi
3.5 mm AV socket wiring

Cable type Sleeve Ring 2 Ring 1 Tip Works?
Raspberry Pi Video Ground Right Left V
)
VGA adapter Cable doesn t Work MP3 player Ground Video Right Left x
The Raspberry Pi HDMI ogtput QOes not provide a Camcorder Right Ground Video Left
signal that can be used with a simple HDMI to VGA
iPod AV Cable Video Ground Right Left V

cable. Instead, you will need a proper converter like
this one: magpi.cc/2u8WXgé6.

This example also comes with a 3.5 mm cable for
the audio signal. ] —

Swap yellow and red RCA cables

Keyboard outputs

incorrect characters

Raspbian defaults to UK keyboard settings. It does
try to figure out what kind of keyboard you’re
using, but it won’t always get it right. To change
the keyboard settings, go to Menu > Preferences

> Raspberry Pi Configuration. You can then
change the localisation settings, including the
keyboard language.

RCA composite video out of sync

Does the display on your TV resemble the output TAKE IT TO THE FORUMS

from a badly distorted VHS tape? This is usually a

sign that the ground and video signals have been We've covered a lot of common issues in this feature, but not every problem
swapped over inside the monitor cable. If you made will be here. If you can't find a solution to your problem, it's always best to

the cable, you may be able to fix this problem; if head to the Raspberry Pi forums: magpi.cc/1NIH5rQ.

not, you’ll need a new cable. Alternatively, if you’re Before posting a question, you should always search the forum in case
getting no video at all, you may just need to swap anyone else has experienced the same problem, and solved it. If not, drop a
the yellow and red cables — see diagram, top right. post in the most suitable place and the Pi community should give you a hand!

They're great like that.

raspberrypiorg/magpi August 2017 MdgPi | 23



Teature

Get yourself back online
with these tips for fixing
your nhetwork connection

ccess to the internet is essential for anyone

using a computer. When you start having

network problems and can’t get to Google,
stay calm. Troubleshooting your network might
involve a very quick fix or an extremely complex
solution, but most problems will have a simple cause.
Here are some things to look out for.

SIMPLE STEPS

In the Raspberry Pi desktop environment, you’ll

see a symbol near the top right-hand side that lets
you know the status of the network connection. It
will show two wires plugged together for a wired
connection, or the standard wireless logo for wireless
internet. If there’s no network connection, you’ll see
the wires unplugged, along with a red X. If there’s a
network connection but no internet access, the Pi will
When a wired still appear to be connected.

Ethernet If you’re using a wired connection, make sure
connection is the Ethernet connector is firmly pushed into the
detected, the Raspberry Pi. A loose cable will not always touch
the connectors.
is disabled, so If you’re using wireless, double-check that you’ve

they cannot entered the password correctly, and make sure you
both be are trying to connect to the correct network. If you’re
using a WiFi dongle, make sure it is firmly pushed into
the USB slot.

Always check the network connection indicator to figure out
whether it's a network problem or an internet connection issue

wireless LAN

used at the
same time

Use this app to find a good place to locate your Raspberry Pi

= nm LOCATION.
5 12 LOCATION

If your wireless internet is intermittent, you may
x need to re-evaluate your Pi’s position relative to
1 % 1 1 * 27 your router. Use a smartphone to determine the
x * strength of your wireless network in different
locations. On Android, you can use the Wifi Analyzer
app: magpi.cc/2ucqLbx.
. This app also shows the traffic on specific WiFi
1 1 o 27 channels. You may find that changing your router’s
wireless channel will improve the signal quality.

0 %
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only need to change one line

THE RIGHT
ADDRESS

If you’re using an older Raspberry Pi, you may have
set a static IP on the network interface. If your current
network doesn’t support that specific IP, it won’t

let your Raspberry Pi connect. Short of wiping the

SD card and reinstalling Raspbian, the best solution

is to change the settings so that the router assigns
the IP address.

On older Raspbian installs, you’ll need to edit the
/etc/network/interfaces file and change the eth@ and
wlan@ lines to be iface eth® inet dhcpand iface
wlan@ inet dhcp respectively.

On newer installs of Raspbian, the /etc/dhcpcd.conf
file is the one to edit for wired connections. Change
the relevant line to iface eth@ inet manual.

For wireless connections, you’ll need to look in
/etc/wpa_supplicant/wpa_supplicant.conf and
remove any lines that assign a fixed IP.

It may look complicated, but you'll I

SSH is now turned off by
default - you can turn it back

RASPBERRY Pl PROBLEMS SOLVED

/
] ~

If you set up the wireless
using the desktop, the Pi will
remember the settings while
in command-line mode

OFF THE PI

Sometimes the problem may lie with your network,
rather than with the Pi itself. If you're using Ethernet,
check all the connections to the modem or router. For
wireless connections, make sure that other devices,
such as smartphones, are able to connect to the WiFi.
If you have a network connection, try dialling into
the main router by opening the browser and entering
the IP address of the router. If you don't know the IP

address, you can usually find it on the back of the
router. From there, you can get an indication of what
might be wrong. For example, you may find that there
is no internet connection to the router, or that you
need to reset the password.

If all else fails, reset the router by turning the power
off at the wall for about 15 seconds.

COMPATIBLE DONGLES

on in Menu > Preferences >
Raspberry Pi Configuration

To set up a wireless
connection in the command
line, follow this guide:
magpi.cc/2hQhw\W4

raspberrypi.org/magpi

If you're using an older model Raspberry
Pi, it won't have built-in wireless LAN like

the Raspberry Pi 3 or Zero W. In that case,

for wireless internet, you'll need a WiFi
dongle. Not every WiFi dongle works on

the Raspberry Pi, so if you have one lying

around you'll need to check it against

this handy list: magpi.cc/1P2pwPH.
Otherwise, you can buy an official

dongle here: magpi.cc/2ckZADU.

August 2017 MdgPi



SOFTWARE FIXES

What do you do if software goes wrong? Follow our handy tips!

ith all the different projects you could run
on a Raspberry Pi, it’s likely that you’ll run
into a hiccup with a piece of code, an app, or

(.

26

an installation. Here are some tips to get everything
running smoothly again.

Installation issues

Installing software should be easy. Search for it
in the graphical package manager, or install it
using the Terminal. Sometimes the installation
may not go as planned, so here are some tips for
successful installing.

01: Update the software list

Raspbian can only install software if it knows that the
software exists. The Pi should update its software list
automatically when you open the graphical package
manager, but you’ll need to update the list yourself
before installing software from the Terminal. Do this
by running sudo apt-get update.

MdgPi August 2017

02: Try the Terminal

If you’re having problems with the graphical package
manager, it’s a good idea to use the Terminal instead.

It probably won’t make it easier to install the software,
but it should be easier to figure out what went wrong.
To install software via the Terminal, use sudo apt-get
install followed by the name of the package. You may
need to check the correct name of the package online.

03: Missing dependencies
Sometimes a piece of software won’t install because
a vital component is missing from the software list.
The error output at the end of an attempt to install
software using the Terminal should give you a clue as
to which component is missing. An internet search
will help you to find the missing package, as well as
instructions on how to install it.

04: Updating software

Tweaks and updates to software in Raspbian occur
fairly regularly. If a program isn’t working properly,
you may need to update it. This can be done by
updating the software list as described above, and
then using sudo apt-get upgrade.

raspberrypi.org/magpi



Teature

RASPBERRY Pl PROBLEMS SOLVED

Code debugging

You’ve spent ages building your Python program,
and now it won’t work. We can’t help with specific
errors, but we do have some tips on how to track
down problems.

01: Check syntax

Everyone forgets a colon or an apostrophe every now
and then. Have a read through your code and make
sure it all makes logical sense. If you press F5 to run

it in the IDLE shell, IDLE may highlight any weird bits
of the code for you to look at. Don’t forget to pay close
attention to indents in your code.

02: Read the error message

If there’s a problem with code you’re running in IDLE,
you will usually see an error message highlighting
where and why the code went wrong. Google the exact
wording of the error to track down the problem.

03: GPIO issues

If you cancel a program without giving the proper
GPIO exit instruction, you may get some strange
results next time you run the program. In the shell,
type GPIO.cleanup(). To be extra safe, exit the IDLE
shell and start it again.

04: Running at startup

Some projects need a script to be run at boot. Our
favourite way of doing this is to edit the profile

file using sudo nano /etc/profile. Add python
script.py &atthe bottom, replacing script.py with
the location and name of your script. You can also turn
off boot to desktop if you need to.

raspberrypi.org/magpi

QUICK ANSWERS

Q: Is Adobe Flash available on Raspberry Pi?
A: Yes, via the Chromium browser.

Q: Help! | can't type a password when it asks for it!
A: The Terminal won't show your password in
asterisks as you type, but it's still being entered.

Press ENTER to complete the password entry.

Q: How can | turn the screensaver off?
Q: This is not straightforward, but there's
a forum thread that explains the process:
magpi.cc/2uc3zKP.

Q: The zip file | downloaded doesn't work.
A: First, try downloading it again. If that doesn't

solve the problem, install 7-zip and use that to
Rolling back

unzip the file.
We’ve seen problems caused when new software on
Raspbian negatively affects other software. The best
solution for this is to keep regular backups of your
SD card. Back up a version of the card that you know
will work, so that you can reinstall it if you need to.
Otherwise, try carefully removing the new software
using sudo apt-get remove.

BEYOND THE PI FORUMS

Sometimes a problem may not be caused by the
Raspberry Pi, but by the software you're using. In
this case, always check to see whether there is

a specific forum for this piece of software. If not,
try general help websites such as Stack Overflow
(stackoverflow.com), which is full of veteran
developers and computer users who can usually
help you figure out a solution.

August 2017 MagPi | 27




UBSCRIBE TODA

FREE

PIZEROW

AND FREE CAMERA MODULE
CONNECTOR AND USB / HDMI
CONVERTER CABLES

Y AND RECEIVE A

h

!

28 | MdgPi August 2017

Subscribe in print for 12 /
months today and receive:

® A free Pi Zero W (the latest model)

® Free Pi Zero W case with three covers
o /Free Camera Module connector

® Free USB and HDMI converter cables

Other benefits:

o Save up to 25% on thé/price

® Free delivery to your door

® Exclusive Pi offers and discounts

® Get every issue first (before stores)

L —
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Build details are
on Jack's blog
(magpi.cc/
2s07JZo)

The booth
took 20 hours
to make

By default
it takes four
photos per
session

Live internet
backup of
photos is
possible with a
WiFi connection

External lights
would improve
night-time shots

JACK BARKER

Jack is based in Melbourne, Australia.
By day he works as a business analyst;
by night he writes code, blogs, and
muses on all things technology.
jackbarker.com.au

PHOTO BOOTH

Need a wedding photo booth? You could always build your own...

s first Raspberry Pi
projects go, building

a photo booth for your
own wedding is an ambitious

and potentially stressful one, but
that’s just what Jack Barker did
for his and fiancée Pam’s big day.
“T’ve always been fascinated with
tinkering and programming but,
in truth, the primary motivation
came when I saw how much it
cost to hire a photo booth!” After
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getting quotes upwards of AS500
(£300), and struggling to stay
within their wedding budget, Jack
realised he could build his own
booth for considerably less money.
“When I first mentioned
the idea to Pam, she was a bit
nervous that it might be another
project that wouldn’t eventuate!”
admits Jack. The booth took him
20 hours to complete, spread
across a number of weekends.

absolutely essential, including a
printer to produce instant copies
of the photos.

Since the venue had no WiFi
connection, Jack’s plan to run a live
backup of photos to the internet
also had to be shelved. “My low-
tech solution was to simply write
the images to the Pi’s SD card (and
hope for the best). The following
day I was very glad to see that they
had all been saved without issue,

As the wedding date drew closer,
Jack had to de-scope some ideas
that weren't absolutely essential

This included writing all the code
from scratch - available on his
GitHub page (magpi.cc/2sNsRic).
“Certainly a lot of that time was
spent trying out different ideas,
and deciding on which features

to include.” As the wedding

date drew closer, Jack had to
de-scope some ideas that weren’t

and [ was then able to post them
online for the guests to view.”
Building the main booth
structure from plywood, Jack cut
out a section for the LCD screen
and drilled holes for a large arcade
button below and the Raspberry Pi
Camera Module above. Jack used
a 3D-printed part to align the
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PHOTO BOOTH

The happy couple, Jack and Pam,
trying out the home-made photo booth.

camera perfectly with the hole,
but he says this is optional. The
Pi itself was also taped to the rear
of the front panel. For improved
lighting of indoor shots, Jack
placed a strip of white LEDs across
the top, later adding a simple light
diffuser using an angled piece
of wood.

Jack set up the Python software
so that when a guest presses
the button, a seven-second
countdown is started. “During
the first four seconds of the
countdown, an instructional slide
is shown (‘Get ready for photo 1°).
For the final moments of the
countdown, the participants

can see themselves live on the
screen and they can also see
the timer counting down. This
helps the participants to position
themselves in front of the shot,
before the photo image is taken.”
Once the first photo is taken, the
cycle repeats to capture a total of
four images.

So, how did it work out on
the big day? “The guests were
impressed that I’d been able
to build it myself,” says Jack.
“It served as a great topic of
conversation, and helped get some
of the guests mingling. Oh, and
yes, there has been interest from
people asking to borrow it.”

BUILD A PHOTO BOOTH

Wooden cabinet

LED light diffuser

Light from a strip of ultra-
bright LEDs is diffused by

an angled piece of wood

The LCD screen gives
instructions and then a

live view of the guests
to aid positioning

Jack used pieces of plywood joined
with brass brackets to make the photo
booth's cabinet, sawing out a carefully
measured section of the front panel to
fit the LCD screen.
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An angled piece of wood is used to diffuse
the light from a strip of white LEDs. Rather
than acting as a flash, Jack opted to keep
the LEDs turned on, which avoided tricky
timing issues.

Wire it up

Currently, Jack is using three separate
power sources - one each for the Pi, LCD
screen, and LEDs. However, he's looking
to switch over to a dual rail power supply
(5V plus 12 V) soon.
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STEVE UPTON

His parents would say he was breaker,
but today he's more of a maker.
Founder of Makespace (Cambridge)
and creator of lots of amazing projects.
steseu.com / twitter.com/steseu

Pl BASH

When Steve Upton was challenged to have a bash at creating a Hi Striker machine,
he hit the ground running and ended up developing two

It took Steve 24
hours to make

It cost £174

in parts from
RS, Pi Hut,
and Pimoroni

The current
highest scorer
is a blacksmith

The frame was
designed using
Autodesk'’s
Fusion 360

Arefined
version will
be ready for
a Maker Faire
in October

Below Steve built
a full working
version, adding an
element at a time.
This image is an
early prototype

f you’ve ever been to a
fairground and been asked
to ‘step right up’ and ‘test
your strength’, then you may have
found yourself smashing a hammer
against a puck in an attempt to ring
a bell. These so-called Hi Striker
attractions have been popular
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for close to 100 years, but when
Steve Upton based one around an
Arduino, he didn’t realise he’d soon
have a Pi-based hit on his hands.
The idea for building the gaming
machine came from a company
called AJW Distribution, which
had approached the members

The bellrunson 12 V. It
can be triggered using
GPIO Zero and a 5 V relay
between the bell and a
12 V power supply

Steve wants to create a
webpage of high scores
and get the machine to
take a photo of each player

The hardest challenge
was the physics involved in
getting the strike to relate
to the height of the lit LEDs

of Cambridge’s inventing shed,
Makespace. The firm wanted
something to entice people to its
stand at a forthcoming trade show.
“They wanted it to look like the side
of a building, and use their cladding
and roofing material,” says Steve,
who agreed to the challenge.

New and improved

Having created the machine, which
made lots of cash for charity, Steve
decided to play around with his
design. “I knew it would be great
for Raspberry Pi parties, Jams, and
Maker Faires,” he says. “So I just
had to create another improved
version based on what I’d learnt.”
He was going to call it Pi Striker,
“but I couldn’t write an ‘r’ with the
displays I intended to use for the
scoreboard.” Instead, he named
the new project Pi Bash and,
grabbing a wad of paper, began to
draw up his plans.

Steve knew what he needed to
create the machine based on his
previous experience. He decided to
use the small, inexpensive plug-on
RasPiO Duino board for sensing
and the focused monitoring of
speed. He also used a pressure
sensor which could detect a hit,

a vertical LED strip that would
light up according to how hard the
impact was, some star-shaped
LED strips, and a bell with a relay
controller to produce a satisfying
ding if the player was successful.

He also wanted a mode selector
so that the game could be
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Pl BASH

FAIRGROUND ATTRACTION

Give it a whack

When you go for a strike, a hit triggers the vibration
sensor. The Arduino calculates the power of the strike
based on the amount of vibration, and converts it to a

number between one and 100.

adjusted to suit the player; a reset
button; and the aforementioned
scoreboard. “Once I had all of
these working individually, I built
the wooden support structure and
started to add them together,”
recalls Steve. “I could then

tune the sensing calculations

to make it feel as realistic as
possible.” There wasn’t much
programming involved, although
the sensing code, written in C, was
fairly complex.

What are the scores?
The scoreboard was tricky to make.
Rather than using a screen, Steve
wanted to use three large seven-
segment LEDs to make the score
clear, “but I couldn’t find anything
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Lighting the way

The information is sent to the Raspberry Pi, which
loops and counts up to this value. It triggers updates
to the LED strip and the scoreboard via a GPIO port.

Ring that bell

If the measured power is enough to reach the top, the
relay is triggered, again via a GPIO port. It connects the
12 volts to the bell, which then rings. Success!

appropriate for sale, so I built
one myself.” The seven-segment
displays were connected to a
laser-cut Perspex mount which
Steve built at Makespace.

and sensors also proved tricky to

control, so they remain connected

to the Arduino at the moment.
More difficult, though,

is actually achieving a high

['ve got a couple of sensitivity settings
so parents and youngsters can compete
on a more equal footing

“I'bought the LEDs online,
along with the components to
build controllers for them,” he
adds, referring to the resistors,
shift registers, optocouplers,
and connecting wire. “This was
one of the more challenging
parts of the project.” The lights

score, but the reaction to the

Pi Bash has been great. “I’ve

got a couple of sensitivity

settings so parents and youngsters
can compete on a more equal
footing. We had a lot of laughs

at the Pi Birthday Party earlier
this year.”
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CHRIS RIEBSCHLAGER

Chris Riebschlager works as Lead
Software Developer at Dimensional
Innovations, Kansas City, USA.
magpi.cc/2u887BsS

- 12-FOOT

ELECTRIC GUITAR

Asked to create ‘something amazing’ for the entrance of Boulevardia,
a two-day music festival, the team at Dimensional Innovations didn’t disappoint

The build took
five weeks
in total

The body is
constructed
using layers

of MDF

Stickers were
printed on
3M Controltac

It uses HDMI
for sound

Watch the build
process at
magpi.cc/
2udZooz

oulevardia is Kansas City’s
two-day music, food

and beer event, this year
drawing crowds to the historic
Stockyards District. When tasked

with making something ‘amazing’

to be situated just inside the
entrance to the event, the team
at design firm Dimensional
Innovations “wanted to create
something iconic, interactive,
and engaging.”

Although the idea of a 12 ft
(3.6 m) tall electric guitar wasn’t
the first concept to grace their
ideas board, it was the one that

Arcade buttons connected
to GPIO pins are used to

select chords, and choose
a clean or dirty sound

stuck. And soon afterwards,
the team got to work designing
both the internal electronics and
external aesthetic of the build.
“Honestly, I didn’t know if we
would be able to make this happen,”
explains Chris Riebschlager, Lead
Software Developer at Dimensional
Innovations, “but I was smitten with
the idea, so I pitched it to the team.”
Once the idea was green-lighted,
Chris finally had an excuse to use
the Bare Conductive capacitive
touch board he’d been coveting
as a maker, and they got to work
on a prototype.

Stickers designed and printed
in-house represent the
breweries and bands taking
part in the Boulevardia event

Prototyping
The plan was to use 16-gauge
galvanised wire as the conductive
material connected to the board,
allowing the team to assign a WAV
sound file to each wire. ‘Strum’ a
wire and the board would register
the connection and task the
Raspberry Pi with playing back
a specific note. A simple enough
idea, and one we’ve seen countless
times using fruit and tin foil — but
for a 12-foot guitar, there was a
little more work to be done.

Chris originally attempted to
source his guitar note WAV files

16-gauge galvanised strings
connect to a Raspberry

Pi via a Bare Conductive
capacitive touch board
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THE PLAYABLE 12-FOOT ELECTRIC GUITAR  Projects

A GIANT IN THE
MUSIC INDUSTRY

Everyone worked together to create a realistic-looking guitar,

utilising all the talents of the Dimensional Innovations team

Strings
from an electric guitar, but finding  BUilding the body A Bare Conductive board recognises capacitive
the sound to be “inconsistentand  Turning to the design team for touch via 16-gauge galvanised wires running down

weird”, he decided to instead take ~ help with the guitar body, the the body of the guitar. Each touch triggers the
the pre-existing sound files from team created an authentic-looking playback of a specific WAV file.

GarageBand. Still not content with  set of stickers, each depicting

the prototype, the team moved on  breweries and bands taking part in

One of the most exciting,
challenging, and rewarding
projects I've been a part of

to incorporating arcade buttons the event. These were then printed

linked to the GPIO pins, allowing for inclusion on the MDF and steel

the user to select a specific body of the instrument, all

chord before strumming the put together in-house by the Sound

strings. The Python code awesome engineering team. Arcade buttons connected to the GPIO pins allow
would then determine which The final piece was iz e el el e el el e ey ey ey
sounds to play, and for installed inside the entrance i e e A
how long, based on the to Boulevardia, and received (el S el Zlade Sl AT
user interaction with the overwhelming reactions from el e cretel

strings and buttons. all attendees to the event. “This

project was without a doubt one of
the most exciting, challenging, and
rewarding projects I’ve been a part
of,” continues Chris on his blog
entry for the build. “From concept
to execution, the entire project took
only five weeks. The fact that we
pulled this off in so little time really
speaks to the talent and dedication
of the people I get to work with.”

If you happen to be in Kansas

City, you can visit the guitar at Body

the Dimensional Innovations shop, The body of the guitar is built from steel and MDF,
where it sits proudly on display the latter shaped by the engineering team at

for visitors to play — a constant Dimensional Innovations using a CNC router. Stickers

reminder of what can be achieved representing performers and other participants in the
with a little hard work and event adorn the completed orange body.
a great team.
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UTTAM GRANDHI

An Elastic Mind enthusiast based
in Brooklyn, NY. His interests span
electronics, sculpture, biology,
maths, animation, and origami.
utt.am/about

It was important to get the viewing
angle, screen brightness, and
orientation right for each screen

By mixing the Pi-powered
screens with static mini-
billboards, a busy, realistic-
looking Times Square emerged

The cabling is tucked away
and hidden behind the screens
to make for a tidy installation

ULLIVER'S GATE

When recreating Times Square in miniature, Uttam Grandhi and his team knew the
bright lights of its billboards would have giant appeal

Gulliver's Gate
is inspired

by the satire
Gulliver's
Travels

It features
landmarks
from more than
100 cities

Visitors use
telescopes to
see the detail
close up

The Pis are
connected

to a 24-port
Netgear switch

The team
also bought a
Raspberry Pi
starter kit

isit New York and it’s hard
not to be overwhelmed

by the glittering scale

of Times Square. Spread over
millions of square feet, flanked

by skyscrapers and assaulting the
eyes with brightly lit advertisement
hoardings, it is one of the world’s
most visited tourist attractions.

MagPi August 2017

While the owner of the globe’s
largest and most expensive
digital billboard once declared,
“size matters in Times Square,”
one company, Gulliver’s Gate, is
proving that small can be equally
beautiful. It has spent S40 million
bringing together 50 nations in a
49,000 sq ft (4,552 m?) miniature

world, situated in the former New
York Times building on 44th Street.
What’s more, it has made great use
of 23 Raspberry Pi Zeros.

Pi-powered models
By connecting the Pis to 23
ten-inch and seven-inch screens,
artist and design technologist
Uttam Grandhi, together with
a talented team from Brooklyn
Model Works, has brought a
1:87 scale recreation of Times
Square to life. They have used
the displays (which were bought,
complete with LCD control
boards, from the electrical retailer
Banggood.com) as small-factor
digital billboards, fixing them to
both the fagades and terraces of
the recreated towers.

“We’ve situated them on
different miniature buildings
and in different orientations,”
Uttam says, having used them
in both landscape and portrait
mode. “Our designer, Martin
Eisler, had to design a modular

raspberrypi.org/magpi



GULLIVER'S GATE

LIGHTING UP A MINIATURE TIMES SQUARE

Managing the screens

Connecting the Pis

Shining a light

The screens were used in portrait and
landscape modes. Based on their power
draw, the displays were distributed
between different power supplies

The 23 Pis are installed across four hub
plates, with varying lengths of power and
HDMI cables running between the Pis and
the screens. The displays are configured

Testing the screens is difficult because the
Pis are under the platform — one person
troubleshoots the Pis while another checks
the displays. The adverts run via Adafruit's

situated at the back of the hub plates.

mounting mechanism for the
frames based on the Banggood
screen dimensions. The frame
parts were cut in 1/8-inch black
cast acrylic and they were sanded
and glued together with Acrifix
solvent cement.”

Construction and power
To fix the screen controllers to

the displays, the team marked the
mounting holes before drilling and
taping them. “We only used three
holes to mount the controller board
because its base is not flat, and
tightening all four screws would

to use HDMI by default.

also provided a measure of safety.
“The board wouldn’t be damaged if
someone accidentally yanked the
cables,” Uttam tells us. The cables
were then secured with ties to keep
them contained.

Coding real adverts

With construction complete, they
could prepare the Pi Zeros. Uttam
burned the Raspbian OS on to a
microSD card using the Etcher app,
and installed Adafruit’s Raspberry
Pi Video Looper to display the ads.
“We used a library, so most of the
programming task was already

Targeting visitors by running
real ads on the miniature
screens 1s a real stroke of genius

have tilted it to one side,” explains
Uttam. “The screens were attached
to the frames using clear VHB tape.”
With all of that in place, they
could attach the HDMI and power
cables to the screen controllers.
There wasn’t enough room for
standard cables, so they used
HDMI flat angle adapters, which

raspberrypi.org/magpi

complete,” he continues. “But to
save some time in configuring all
of the Pis, [ wrote scripts to set
static IPs and change host names.”
The Pis have been connected to a
24-port Ethernet switch and placed
under the platform on which the
models sit. The team could then
begin to gather adverts, which

Raspberry Pi Video Looper.

Above Every cable has been carefully labelled to make
troubleshooting easier

have come from the advertisers
themselves, shining brightly from
the buildings they adorn. “They
really added depth and dynamism
to the otherwise still buildings,”
Uttam says of the final result.
“Targeting visitors by running real
ads on the miniature screens is a
real stroke of genius.”
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Tulorial | RASPBERRY PI101: INSTALL THE RASPBERRY Pl DESKTOP X86

I N S I AI I I H E This tutorial erases the operating
system running on your computer.

Use your free DVD to run and install the Raspberry Pi Desktop on your PC
or Mac computer

egular readers will know that we first gave You can still run the Raspberry Pi Desktop on a PC
away a copy of The Raspberry Pi Desktop or Mac computer, but now you can also install the
operating system with issue 53 of The MagPi. —Raspberry Pi Desktop on your hard drive, replacing
Well, we’re back with an update. The latest version the previous operating system.

of The Raspberry Pi Desktop x86 is included with the This DVD is an ideal tool for adapting an old

>Mac O{Z?With print edition of this month’s magazine. computer into a useful coding and hacking machine.
optical drive

The Raspberry Pi Desktop x86 runs on most
>The Raspberry Pi computers with an Intel x86 architecture. We’ve
Desktop x86 DVD .
run it successfully on many old PC
» The Raspberry Pi and Mac devices.

Desktop x86 I1ISO

image file Let’s look at how to go about doing

a basic installation of The Raspberry
Pi Desktop x86 on an old PC or
Mac computer.

» USB thumb drive

The Raspberry Pi
Desktop looks just the same
as it does on a Raspberry Pi

The latest version of
The Raspberry Pi Desktop
x86 enables you to install
the operating system on
your computer

The Raspberry Pi
Desktop DVD can be used on
a PC or Mac computer




INSTALL THE RASPBERRY PI D

HOW TO:
USE THE RASPBERRY
PIDESKTOP X36

01

>STEP-01

Boot from DVD on a PC

The free DVD bundled with the print edition of The
MagPi #60 can be used to start up a PC or Mac computer
with an optical DVD drive. Turn off your computer and
insert the DVD. Most PC computers are set up to boot
from the optical drive before the hard drive, and you
should see the Debian GNU/Linux installer boot menu.
If it does not boot from the DVD, you need to change the
Boot Priority Order in your BIOS settings. On most PCs,
you press F1 during boot to do this.

Apple Mac computers are designed to boot from the
hard drive first, and not from an inserted DVD. Insert
the DVD into your Mac and shut it down. Now power it
up and hold down the C key. The menu should boot from
the DVD. If this doesn’t work, hold down the Option key
(marked ‘alt’) and choose the EFI Boot icon.

02

>STEP-02

Boot menu

The new version of The Raspberry Pi Desktop
features a boot menu. Here you’ll see seven options:
Run with persistence, Run and reset persistence, Run
without persistence, Install, Graphical install, and
Advanced options.

03

>STEP-03
Run Raspbian
Choose ‘Run without persistence’ to quickly boot
into the Raspberry Pi Desktop x86 operating system.
Here you can experiment and play around. Be
warned that it won’t save any files. For this, you
need to choose ‘Run with persistence’, and attach

a USB pen drive to your computer. The persistence
drive saves any files you create while using Raspbian
(see The MagPi #53 for an in-depth explanation

of persistence).

>STEP-04 04
Install

Two options are available: Install
and Graphical install. Both offer

a similar experience. You’ll find
additional settings under Advanced
options. Select Install. Run through
the Configuration options using the
arrow keys and Enter. You’ll now see
‘Loading additional components’.

>STEP-05

Partition disks

You have several options for partitioning disks. We’re
going with ‘Guided — use entire disk’. Note that this
wipes the original operating system! Choose the correct
disk from the Partition Disks list and ‘All files in one
partition’. Finally, select Finish partitioning, write
changes to disk, and Yes.

05

>STEP-06
Installing the system
Wait for the system to be installed on your hard
drive. Choose Yes to Install the GRUB boot loader
on a hard disk, and pick your device from the

list (typically it will be /dev/sda on a single disk
machine). When you see ‘Installation is complete’,
click Continue. Your computer will reboot and start
up in the Raspberry Pi Desktop.

Problems?

raspberrypi.org/

forum




DISCOVER

SCRATCH 2.0

Scratch 2.0 for Raspbian is packed with new features, and now runs offline

You'll
Need

he latest update to Raspbian has brought the

2.0 for Raspberry Pi sits alongside Scratch 1.4
in the Programming menu, and brings a range of new
features to the Scratch experience.

Scratch 2.0 is compatible with a vast range of projects
available on the Scratch website (scratch.mit.edu).
You can run Scratch 2.0 projects in the Chrome browser
inside Raspbian, and then click File > Download to your
computer. Open the file in the Scratch 2.0 program
running on your Raspberry Pi (using File > Load Project),
and the project will run offline.

Scratch 2.0 projects may not be compatible with
the older Scratch 1.4 program, because Scratch
2.0 introduces lots of new features and blocks.

One of the most exciting new features is cloning,
which enables a sprite in your stage to clone, or
semi-duplicate itself. Cloning is a powerful object-
orientated programming (OOP) feature that was not

N

T Scratch 2.0 offline app to the desktop. Scratch

supported in Scratch 1.4. It’s an essential part of
many games and projects.

You can also create custom blocks in the More
Blocks section. This enables you to build your own
blocks, and combine scripts that you use regularly
into a single block.

There are plenty of other new features, including a
sound editor, Time blocks, and vector editing. You can
find a list of all the new features on the Scratch Wiki
page (magpi.cc/2s9T9ds).

HOW TO: USE
NEW FEATURES
IN SCRATCH 2.0

>STEP-01

Backdrop name

A new backdrop name block enables sprites to
respond to specific backgrounds. You’ll find backdrop
name at the bottom of the Looks block set. Drag it

into an Operator block inside a Control block, such

as:wait until backdrop name = desert and say
Desert Level for 2 seconds.

raspberrypi.org/magpi



>STEP-02

Cloning

Cloning is a big deal in Scratch 2.0. You could create a
single space alien, and clone it to provide a swarm of
enemies. You can also delete cloned sprites when they
have completed tasks. Start by dragging a when space
key pressed block to the Scripts area.

02

>STEP-03

Create a clone

Now click on Control, and at the bottom you’ll see a
create clone of myself block. Connect it to your
when space key pressed block. The clone will
appear in the same location as your sprite: press the
SPACE bar and it will look as if nothing has happened.
Click and drag the sprite, and you’ll see that the clone
appeared on top of the original sprite. Right-click and
choose Delete to get rid of it.

03

>STEP-05

Delete clone

Another neat feature is that clones can delete
themselves. The Delete command makes it easy
to quickly add and remove sprites from your scene
(perfect for spawning and destroying enemies in a
game). Add a delete this clone block to the bottom
of thewhen I start as a clone block. Now the
clone will announce itself and then disappear.

>STEP-06
Record video

Creating animations is one of the joys of Scratch, and
a new Record Project Video option enables you to send
a Scratch game or animation straight to a video clip.
Choose File > Record Project Video and click Start
to begin recording. A countdown will begin, and the
recording will start. When you’ve finished recording,
click the Stop icon below the Stage. Click Save, and the
movie will be saved as a Flash Video (FLV) file. You need
to install VLC to play back the movie (videolan.org/vlc).

>STEP-04

When | start as a clone

Clones can automatically run blocks of code when
they are created. Click on Control and drag awhen I
start as a clone block to the Scripts area. Beneath
it, add amove 100 steps block. This helps you to
differentiate between the two sprites. Now add a

say I’m a clone for 2 seconds block. Press the
SPACE bar and you’ll see a new clone appear and
announce itself. Right-click and Delete to get rid of it.

raspberrypi.org/magpi
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CODE IN PYTHON WITH

THONNY

Use the new Thonny IDE to understand what’s going on in your code

honny is a new IDE
(integrated development
environment) bundled
with the latest version of the
Raspbian operating system. Using
Thonny, it’s now much easier to
learn to code. Thonny comes with
Python 3.6 built in, so you don’t
need to install anything. Just open
up the program, which you’ll find
under Menu > Programming. It
offers a lot of advanced features not
currently available in the Python 3
(IDLE) program, which is still
included with Raspbian.

When you start Thonny, you’ll
see a new script editor and a shell.
As with Python 2/3 IDLE, you enter
a program in the script editor and

run it in the shell. You can then use
the shell to interact directly with
the program; accessing variables,
objects, and other program features.

Thonny has a range of additional
features that are perfect for
learning programming. One of the
best features is a powerful, but
easy-to-use, debug mode. Instead
of running your program, it steps
through the code line by line. You
can see the variables and objects
being created, and values being
passed into functions or assessed
by comparators.

You often find debuggers in
powerful IDEs, but they tend
to require you to manually set
breakpoints (places where the

program freezes so you can examine
the code). The approach in Thonny
is much more straightforward.

It also has a range of panels that
enable you to inspect various items,
such as variables, objects, and the
heap (the memory space where
items are stored).

There’s some pretty good stuff in
Thonny for young coders. The ability
to step through your programs
makes it much easier to understand
what happens when you hit Run.

01

>STEP-01

How to use Thonny

Click the Raspberry Pi Menu icon
in the top left of the screen and
choose Programming > Thonny
Python IDE. We’ve used File >
Increase Font Size so you can see
the text more clearly. Enter this
line of code in the script editor:

print("Hello World!")
Now choose File > Save and name
the program hello.py. Click ‘Run

current script’ (or press F5) to see
the output in the shell. As with

raspberrypi.org/magpi



IDLE, you can also enter commands
directly in the shell, such as:

name = "Lucy"
print("Hello " + name)

02

>STEP-02

Countdown

Let’s see how you can walk
through a file and see a variable
change. Create a new script (File
> New) and enter the code in
countdown.py. Click Run and
the code will display ‘10, 9 ... 2,
1, Blast Off!” The n variable starts
at 10. Awhile loop prints it, and
decreases its value as long as it
remains above zero.

03

>STEP-03
Debug

Choose View > Variables and a new
window appears displaying n and its
current value (which is zero). Now
let’s run through it one step at a
time. Click ‘Debug current script’.
The first line will be highlighted.
Click Step Into and the value will

be highlighted. Click it again, and
both n and 10 are placed in the
Variables window.

04
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>PYTHON

>STEP-04
Step through

Keep clicking Step Into and you will
see the value of variable n (which
is 10) added to the comparator and
evaluated to True. Then the while
loop will activate, the value of n will
be displayed to the console, and n
will decrease by 1. Click Step Out
to run through the while loop and
back to the main code.

animals.py

class Animal():
def __init_ (self, c, n):
self.creature = c
self.name = n

05 def get creature(self ):
return self.creature

def get name(self):
return self.name

animals = []

animals.append(Animal(
animals.append(Animal(
>STEP'05 animals.append(Animal(
Recursion

Thonny’s debug mode makes
it easier to understand concepts
such as recursion. Our
countdown_recursion.py program
runs a countdown recursively (a
function which calls itself from
inside itself). When the function
calls itself, a new window appears
with the function. Keep stepping
through to see the values updated.

for animal in animals:
name = animal.get name()
creature = animal.get creature()
print(name + + creature)

(1] def count(n):
if n > 0:
print(n)
count(n-1)
else:
print(

count(n)

>STEP-06

Heap and objects
For a more detailed view, enter
View > Heap and View > Objects.
Now, as you work with object-
oriented code, you can select objects
in the Heap or Variables window
and use the Object Inspector to
check their type and attributes.
The animals.py code creates
animal objects with creature and
name instance variables.

countdown.py

while n > 0:
print(n)
n-=1

print(
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MIKE'S PI BAKERY

MIKE COOK

Veteran magazine author from the old
days and writer of the Body Build series.
Co-author of Raspberry Pi for Dummies,
Raspberry Pi Projects, and Raspberry Pi
Projects for Dummies.
magpi.cc/259aT3X

FIDGET SPINNER

Fidget spinner
Phototransistor

NPN transistor
and wires

Stripboard

Table light

Wood strip and
MDF sheet

MAZE RUNNER

Use your fidget spinner to speed through a medieval maze

idget spinners are the latest craze among young
G people. They are spreading fast, so we hope they
don’t peak and disappear before this publication
hits the news stands! Fidget spinners might appear to
be totally useless, but in this month’s Pi Bakery we will
transform one into a unique games controller.

We decided that the low-friction, free-spinning
fidget would be most effectively interfaced with a
computer using an optical connection. We dug out the
SFH3410 sensor we used in the Amaze project in issue

39 of The MagPi, hoping that the small, low-profile
sensor would sit neatly under the arms of a spinning
fidget. Sadly, while it would fit underneath some

types of fidgets, the contrast between shadow and
light was not enough to reliably trigger a GPIO pin.
Instead, we decided to hide the sensor under the lid

of a box, and only admit light through a small hole.
We added a general-purpose NPN transistor to the
phototransistor to generate a robust 3V3 signal to send
to the Pi. Figure 1 shows the schematic diagram.

Octagonal maze
from the Basilica

of Saint-Quentin

IKEA Jansjo
LED work lamp

Fidget spinner rest

Fidget spinner
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FIDGET SPINNER MAZE RUNNER

Figure 1 Schematic diagram of the fidget sensor

SFH3410
Collector [ )

]

b e
Transistor
2N2222 or general purpose NPN

— Not Connected
- Emitter

SFH3410

47K

N\

Raspberry Pi
3V3

GPIO 4

220R*

—{ | ocprio23
c /)
N

2N2222

*0Optional test components - see text

We aimed the light from a bright LED desk lamp
into the sensor’s hole and spun the fidget spinner to
produce pulses of light. We tested the output on an
oscilloscope, but we’ve added an LED to the circuit so
you can test the signal without an oscilloscope. The
LED is optional and doesn’t form part of the working
circuit, so omitting it has no effect on the operation.

The fidgets we used had holes in each arm. This gave
us 12 transitions between light and shadow, or signal
edges, for one revolution of the fidget, as shown in
Figure 2 (overleaf). If you have a fidget without holes,
you will only have six signal edges per revolution. You
can easily compensate for this in the software. You
will need to hold the centre of the fidget spinner down
on the desk with your finger as you give it a spin, but
you should be able to release it once it is moving.

raspberrypi.org/magpi
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MAKING THE
FIDGET SENSOR

>STEP-01

Make the sensor board

We used a piece of 16x12 hole stripboard and surface-

mount components, but you could easily use through-hole
components and drill a hole in the stripboard to allow the light
to shine through. The layout is easier to see in the diagram
(right) than in the photograph (left). Cut the tracks around the
holes in the two places marked with grey in the diagram. To
wire the board to the Pi, we used a six-pin two-row surface-
mount header pin connector.

Wire link other side of board

O O O 0O O OO0 O O OO O
. O O 0O O OO0 O O 0O O
O O O O O OO0 O O O O O
O O O O O OO0 O O O O O
OO0 O O 000000 ®
: o O O O O O O O O O (3 Gnd
H. O J00 O O OO0 O O O O G+ GPIO 4
OSSO0 000 0O 000 G- 3V3
O O O OO0 O O O O O
O O OO0 O O O O O
O O OO0 O O O O O
O O OO0 O O O O O
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light and shadow
as the fidget
spinner rotates

When you have built the circuit, the first test is to
display the fidget speed in rpm (revolutions per
minute). This involves counting the light pulses
produced by the spinner in one second, and then
using that number to calculate the rpm figure. We
used the GPIO callback function to count the edges of
the signal being sent into the Raspberry Pi. To reduce
the load on the computer, we only counted the falling
edges - the signal changing from high to low when

a shadow falls on the sensor. The code for this test

is in sensorTest.py.

The pulse function is called when a negative or
falling edge is detected on GPIO 4. This function does
two things. First, the count variable is incremented,
then the logic level on GPIO 23 is toggled. This

Figure 3
Oscilloscope trace
showing the input
pulse (top trace)
and the GPIO
output feedback
(bottom trace)
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12 Rising

divides the input signal by

two, enabling us to check that

no edges are being missed by

the software. If you have a fidget
with only six transitions per
revolution, change the count
increment to add two to the count
at every falling edge.

Figure 3 shows the oscilloscope
trace, with a 5.6 ms latency
between edge detection and
function call. Note that the pulse
widths are not even - this is
because the angular distances
between transition points are
not equal.

With this simple code, you
can compete to find who can
get the fastest spinning speed
from a fidget (either a standard
spinner or your own customised
lubricated one!). The fastest speed
we measured from our fidgets
was 840 rpm.

Mazes

The word ‘maze’ tends to be used in English, whereas
the word ‘labyrinth’ is more widely used in other
countries. There are many different types of maze -
the one we are going to use is known as unicursal. You
may be more familiar with puzzle mazes, which have
branches and dead ends. In a unicursal maze, there

is only one path to follow. There are no branches, so
you can’t get lost. Unicursal mazes are also known

as processional mazes and are often walked for
contemplation, usually in a religious setting.

The maze we are going to use here is a medieval
octagonal maze pavement from the Basilica of Saint-
Quentin in northern France. Using the fidget, you
can compete to see who completes the maze in the
shortest time, or how far though the maze can you
run with a single fidget spin.

Software
The simplest way to use the edge count to control
progress through the maze is to create a list of the
coordinates of each pixel step along the path. With the
scale we have used in this program, that amounts to
about 8,000 coordinates. The player’s current location
in the maze can be calculated using the edge count as
an index to the coordinate list. In order to generate
the coordinate list, the program starts by finding its
way through the maze and saving each point that it
visits on the path. The end result is a bit of a fudge,
but it does produce a useable coordinate list.

When you play the game, you can choose to see
your progress as a trail, or as a point showing your
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Figure 4 The maze on screen halfway through a run

location. We think the trail is best because it gives
you instant feedback on how much of the maze you
have visited, and how far you have to go. The T key
will toggle between the two types of display. The
SPACE bar resets the player’s position to the start of
the maze, and the RETURN key displays the number
of fidget revolutions made so far. Figure 4 shows the
screen halfway through a game.

The strategy for playing this game is a bit like
deciding when to make a pit stop in Formula One
racing: you have to judge when you can safely give
your fidget another spin without getting your fingers
tangled up in it and bringing it to a stop.

The RETURN key allows you to play the ‘How far
can you get with a single spin’ game. The listing for
this is shown in mazeRunner.py; it requires whistle
and applause sound samples to be stored in a sounds
folder, and the maze image in an images folder.

Taking it further

There are plenty of ways to expand this project. What
about making the trail through the maze gradually
change colour as it gets longer? How about building
two of these fidget readers, so two players can race
their coloured markers through the maze together?
Another variation would be a tug of war game, using
the difference between the two fidget counts to
decide who is winning. When one player’s count
reaches a certain value, that player is declared the
winner. This could be illustrated with graphics of the
rope, and the people tugging on each side.
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>STEP-02
Build the base

Take a piece of 6 mm MDF, about 120x65 mm in size. Drill and
countersink four 3 mm holes for the circuit board. Drilla 1.5 mm
hole to allow the light to get in, and countersink the underside
of this hole to allow room for the phototransistor. Drill and file a
square hole for the pin header. Cut a 22 mm hole out of a piece
of 14x12 hole stripboard to act as the fidget rest, and glue it onto
the board.

>STEP-03
Build the top

Use 10x6 mm strip pine to make four side panels, and glue and

clamp them to the side of the top board. Paint the inside of the

box with matt black paint, and the outside in the colour of your

choice. We chose to paint the fidget rest in one colour, and the

top, as seen through the hole in the rest, in a contrasting colour.
Fit the electronics and connect everything to the Raspberry Pi's
GPIO pins using a three-way ribbon cable.

August 2017 MdgPi | 47



1177y 711 I WALKTHROUGH

mazeRunner.py

01.
092.
003.
004.
005.
006.

007.
008.
009.

010.
011.

012.
013.
014.

015.
016.
017.
018.

019.
020.
021.
022.
023.
024.

025.

026.
027.
028.
029.
030.
031.
032.
033.
034.
035.
036.
037.
038.
039.
040.
041.
042.
043.
044.

045.
046.

import pygame, time, os
import RPi.GPIO as io

pygame.init() # initialise graphics interface
pygame.mixer.quit()
pygame.mixer.init(frequency=22050, size=-16,
channels=2, buffer=512)

os.environ[ 'SDL_VIDEO WINDOW_POS'] = 'center’
pygame.display.set_caption("Figet Spinner Maze Run-
ner"

pygame.event.set_allowed(None)
pygame.event.set_allowed([pygame.KEYDOWN, pygame.

QUIT])

screenWidth = 500 ; screenHeight = 516
screen = pygame.display.set mode([screenWidth,scree
nHeight],0,32)

xPlot = 237; yPlot = 494 ; needsRedraw = True
direction = (0,-1) # start direction

feel = [(0,1),(1,0),(-1,0),(0,-1),(1,1),(-1,1),
(1:'1):(_1:'1)]

rad = 6 # radius of your marker

mazePath = [] ; restart = False
mazePath.append((xPlot,yPlot))

def main():
global xPlot,yPlot,needsRedraw,rad,trail,progress
,count,restart
print("Figet Spinner - Return for progress -
Space for reset")
init() # GPIO
loadResorces()
trail = True
setupMaze(xPlot,yPlot)
progress = 0
markPath()
setupMaze(mazePath[0][0],mazePath[@][1])
rad =
end = len(mazePath)
while True:
whistle.play()
waitFinish()
timeStart = time.time()
count = 0
while progress < end:
checkForEvent()
if needsRedraw:
if trail:
drawMaze (mazePath[progress]
[@],mazePath[progress][1])
else:
setupMaze(mazePath[progress]
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047.
048.
049.
050.
051.
052.
053.
054.
055.

056.
057.
058.
059.
060.
061.

062.
063.
064.
065.
066.
067.
068.
069.
070.
071.

072.
073.
074.

Q075.
076.
077.
078.
079.
080.

081.
082.
083.
084.
085.
086.
087.
088.
089.
090.
091.

092.
093.
094.
095.

[@],mazePath[progress][1])
progress +=1
needsRedraw = False

if count != progress:
progress = count
needsRedraw = True
if progress >= end:
cheers.play()
print("Finished")
print("Maze Run Time",int(time.
time()-timeStart), "seconds™)
waitFinish()
if restart:
progress = end
restart = False
progress = 0
setupMaze(mazePath[progress]

[@],mazePath[progress][1])

time.sleep(2.0)

def markPath():
global xPlot,yPlot,direction,mazePath
print("Finding path please wait")
step = 0
while 1:
checkForEvent()
while pathClear():
(xPlot,yPlot) =
ection[1]+yPlot)
drawMaze (xPlot,yPlot)
mazePath.append((xPlot,yPlot))
if (xPlot > 255 and xPlot < 260) and
(yPlot > 260 and yPlot < 268):
print("Path found ready to play")
return
findDirection()

(direction[@]+xPlot,dir

def pathClear(): # is path ahead clear
nextPoint = (direction[@]*(rad+1)+xPlot,
direction[1]*(rad+1)+yPlot)
col = screen.get_at(nextPoint)
if col == (255,255,255,255) :
return True
return False

def findDirection(): # where is free
global direction
direction = (0,0) # assume stuck
i=29
while i<8:
dirTest = (feel[i]
[0]*(rad+2)+xPlot, feel[i][1]*(rad+2)+yPlot)
col = screen.get at(dirTest)
if col == (255,255,255,255):
direction = feel[i]
= 10 # end search early
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096. i+=1 145. terminate()

097. 146. if event.key == pygame.K_ >PYTHON
098. def setupMaze(x,y): SPACE :
099.  screen.blit(mazeImage,(9,0)) 147. restart = True DOWNLOAD:
100.  pygame.draw.circle(screen, (210,0,0),(X,y), 148. # restart game magpi.cc/1NgJjmV
rad,9) 149. print("Restarting")
le1. pygame.display.update() 150. if event.key == pygame. CEIDE‘IIJESCT
102. K_RETURN :
103. def drawMaze(x,y): 151. print("Pulses from Fidget", Check out Mike's
104.  pygame.draw.circle(screen, (210,0,0),(X,y), progress // 2,"or",progress / Bakery videos at:
. . . magpi.cc/1NqJnTz
rad, o) 6, "revoloutions")
105. pygame.display.update() 152. if event.key == pygame.K_t :
106. trail = not(trail)
107. def loadResorces(): 153. if event.key == pygame.K_s :
108. global mazeImage,cheers,whistle os.system("scrot")
109. mazeImage = pygame.image.load( images/maze. 154.
png").convert_alpha() 155. # Main program logic:
11e. cheers = pygame.mixer.Sound("sounds/end. 156. if __name__ == '_ main__ ':
ogg") 157. main()
111. whistle = pygame.mixer.Sound("sounds/whis-
tle.ogg")

iii def init(): mm.py

114. global count

iS5 count = @ 001. import time, os
116. io.setwarnings(False) 002. import RPi.GPIO as io
117. io.setmode(io.BCM) 003. io.setwarnings(False)
118. io.setup(4, io.IN, pull up down=io.PUD_UP) 004 .
119. io.setup(23, io.0UT) 005.
120. io.add_event_detect(4, io.FALLING, callback ©06. io.setmode(io.BCM)
= pulse) 007. io.setup(4, io.IN, pull_ up_down=io.PUD_UP)
121. 008. io.setup(23, i0.0UT) # feedback
122. def pulse(channel): # call back function 009.
123. global count 010. count = 0
124. count += 2 011.
125. io.output(23,not(io.input(23))) 012. def pulse(channel):
#toptional feedback 013. global count
126. 014. count += 1
127. def waitFinish(): 015. io.output(23,not(io.input(23)))
128. while pygame.mixer.get_busy(): 016.
129. checkForEvent() 017. def main():
130. 018. global count
131. def terminate(): # close down the program 019. io.add_event_detect(4, io.FALLING, callback = pulse)
132. print ("Closing down please wait") 020. while 1:
133 pygame.mixer.quit() 021. interval = time.time()
134. pygame.quit() # close pygame 022. lastCount=count
135. io.cleanup() 023. while time.time() - interval <1.0:
136. os. exit(1l) 024. pass
137. 025. print((count-lastCount)*10, "RPM")
138. def checkForEvent(): # see if we need to quit ©26.
39, global trail,progress,restart 027. # Main program logic:
140. event = pygame.event.poll() 028. if _name__ == ' main_ ':
141. if event.type == pygame.QUIT : 029. try:
142. terminate() 030. main()
143. if event.type == pygame.KEYDOWN : 031. finally:
144. if event.key == pygame.K_ESCAPE : 032. io.cleanup()
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DASHBOARDPI.

ORI

Sense HAT
magpi.cc/
1TGGUt5

Dynamic DNS
service
magpi.cc/

1TSwg3g

Matplotlib
magpi.cc/
1TSwgAt

Apache web
server
magpi.cc/
1TSwis8

Virtual host
magpi.cc/
1TSwiYU

ENTATION WITH SENSE HAT

Plot Sense HAT data with matplotlib, and use a web server
and a dashboard to track it wherever you are

fyou cast your mind back to issue 46 of

The MagPi, you’ll remember that creating a plot
with data obtained by the Sense HAT can help
to make that data more understandable. Using Python
together with the powerful matplotlib library, we can
obtain and plot data from the Sense HAT sensors. If

we have a web server running, we can create a virtual
host where the plots can be stored and accessed over
the network. This is known as a dashboard. There are
existing services that would allow us to do this, but while
most of them require a subscription, this one is free.

Beautiful 3D Data taken from
effect with the Sense HAT can
matplotlib be easily analysed
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For details on how to create a dashboard for Sense
HAT data, check out page 46 of The MagPi #46
(magpi.cc/Issue-46). The previous version of this
project was focused on the use of temperature and
humidity sensors, probably the easiest Sense HAT data
to understand. This time, we are going to take advantage
of the Sense HAT’s powerful motion sensors.

We will use the matplotlib Python library to create
two graphs: a 3D scatter plot using the XYZ position
of the Sense HAT, and a 2D line plot using the angular
velocity data.

Setting up the web server

With a dynamic DNS service, a web server and a
virtual host, you can create your own dashboard.
While these three items are not needed to create the
plots, without them it would be only possible to track
the results locally.

The first step is to create a folder called dashboard
in /var/www. We will use this folder to save the CSV
file generated by the program, along with all the data,
and the HTML or PHP files, and use them to create a
beautiful dashboard.

There are plenty of tutorials available online to show
you how to design your dashboard, so we won’t cover
this here. When you have designed your dashboard,
create a folder called images in /var/www/dashboard.

Importing libraries

Our code needs to import two libraries: csv in order to
write the data to a file, and matplotlib to create the
plots. After importing the libraries, we need to use

the matplotlib.use('Agg') command to allow the
program to work without a running X server. We also
need to import matplotlib.pyplot in order to draw the
plot, matplotlib.ticker to correctly format the axis, and
mpl_toolkits in order to create the 3D plot. We need
NumPy to work with the lists, and SenseHAT to gather
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DASHBOARDPI

>PYTHON

DOWNLOAD:
magpi.cc/2udxSB8

Left It is easy to
create an attractive
online dashboard
using HTML

data from the Sense HAT. Finally, our code imports the
time module in order to add a time.sleep to the while
loop. This should have a value of a second or less if we
want to get a realistic impression of the Sense HAT’s
movements from the motion sensors. The value of the
time.sleep cannot be zero, as the angular velocity is
calculated as displacement/time, and we cannot divide
our displacement value by zero!

Manipulating data

Matplotlib uses lists to create plots, so we need to
create some empty lists. Our code will then take the
data from the Sense HAT and add it to the lists. The
code calculates the angular displacement, and then
divides this value by the time in order to calculate the
angular velocity. All this data is appended to a CSV file
in case we want to check it later, or manipulate and
analyse it using other hardware or software.

Creating the plot

We could take the data from the CSV file and create
the plots, but matplotlib can do this easily using the
lists we have created. Our code starts the 3D plot, then
calculates the minimum and maximum values for the
lists using NumPy. This information is used to format
the axes before cleaning and saving the plot.

A similar procedure is used to plot the angular
velocity against the data count. In this case we are
creating a simple line plot. Our code defines the
limits, using NumPy again to calculate the minimum
and maximum values to be plotted. For this graph
there is no need to format the axes, but we need to
label them to make the plot easy to interpret. Finally,
the code cleans and saves the plot.

The last step, just before ending the while loop, is
to add the time.sleep, with a value greater than zero.
If we want to produce a useful plot, this value should
be close to 1 second or lower. The time.sleep value
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Above Changes in orientation can be tracked using the angular
velocity data

is set as a variable called snooze, just before the start
of the while loop.

Using the data we have collected, we can track how
the orientation of the Sense HAT has changed, and
analyse the angular velocity of these changes.

This code is only an example of the things you
could do using the Sense HAT data. You could create
amazing projects using it as a base for your own code.
You could create different plots, and use the measured
data to correct the orientation of a rover or drone.

You could then monitor the plots to double-check the
resulting behaviour. You don’t even need a Sense HAT
- any sensors could be used, just by changing their
references in the code.

Matplotlib was created by John D Hunter.
He passed away in 2012. Everything your author

has created using his amazing library, including
this tutorial, is offered in his memory.
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RASPBERRY PI

> Raspberry
Shake board
magpi.cc/
2t3BGE5

> 4.5 Hz vertical
geophone
with cables
magpi.cc/
2t36IMo

> Preprogrammed
SD card (optional)
magpi.cc/
2t3myXf

> Full kit (optional)
magpi.cc/2t3Eilg

> Wired internet
connection
(optional)

WENCESLAS MARIE SAINTE

Wenceslas is an electronics engineer who
loves gadgets. He joined the personal
seismometer adventure in 2015 and is
passionate about making this technology
available to anyone with an interest!
raspberryshake.org
twitter.com/raspishake

The Earth is always shaking: from local tremors and traffic rumbling past,
to the big earthquakes that hit half a world away. Now you can see it all!

atching the Earth’s vibrations live from

your computer is now a reality for anyone!

The fun begins with Raspberry Shake, your
professional-grade personal earthquake detection
device, or seismograph. Raspberry Shake conveniently
snaps directly onto a Raspberry Pi, along with
a sophisticated Earth vibration sensor called a
geophone, turning your Raspberry Pi into perhaps
the smallest accurate seismograph in existence
today. With the Raspberry Shake you can actually see,
measure, and analyse the smallest movements of the
Earth. It’s so sensitive that you can see the vibrations
change during rush hour, or with an event at your
local sports stadium!

The Raspberry Shake board
sits on top of a Raspberry Pi

52 | MdgPi August 2017

Get the Raspberry Shake
Turning your Raspberry Pi into a sophisticated
scientific instrument for personal seismology is easy,
and only requires two additional parts: the geophone
and the Raspberry Shake board. Everything you need
is available at shop.raspberryshake.org.

The main sensor is a geophone — think of it as
a microphone for listening to vibrations in the
Earth. The second component is the Raspberry Shake
board. This is a sensor-digitiser that translates the
data from the geophone, so you can actually see what
is shaking! There’s also a preprogrammed microSD
card packed with custom coding, to make everything

The Raspberry Shake was
designed by seismologists

and electronic engineers
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The geophone is a rugged and exquisitely sensitive Earth

motion sensor, finely tuned to accurately measure even the
smallest vibrations and disturbances

work together flawlessly. Alternatively, users can

download the image and burn it to their own SD cards.

You can buy an enclosure for your equipment, or you
can use the laser cutter (DXF) and 3D printer (STL)
source files to cut or print your own.

Assemble the components
Whether you are a novice or an electronics expert,
assembling the parts of this project should take less
than five minutes. Follow the tutorial video on the
Raspberry Shake website: go to magpi.cc/2t319A9 and
select How to Assemble Your Raspberry Shake.

The Raspberry Shake is compatible with many
Raspberry Pi models, so this is the perfect project for

resurrecting an older model and putting it to good use.

The Raspberry Pi B, B+, 2, 3, Zero, and Zero W can all
be used with the Raspberry Shake.

Connect to your Raspberry Shake

Once you have all the parts assembled correctly,
simply connect your Raspberry Pi to the internet
and to a power supply as usual. The Raspberry Pi
power lights will switch on, and a blue LED will
light up on your Raspberry Shake board. Give it a
few seconds to boot, then navigate in your browser
to raspberryshake.local. This will give you instant
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access to the Raspberry Shake local web interface
and configurations, so you can start watching the
Earth move!

Join the official Shaker community
Congratulations on becoming a Shaker! There’s an
awesome community of hundreds of Shakers all over the
world. If you enable data sharing in your device settings,
you will be able to see your device alongside the rest

of the Shaker community in the awesome interactive
global map of live devices, at magpi.cc/2t306k1. With
every device added to this network, the project’s global
data becomes more accurate, and it can analyse how the
Earth as a whole is moving.

Start watching the Earth shake!

The data from your brand new personal seismograph
is presented in the industry-standard format

(called miniSEED). Not only does this make the

data incredibly useful to the global community,

but it also means that you can access and use free
and compatible software to watch earthquakes
happen in real time. The United States Geological
Survey (USGS) developed a program called SWARM
to display and analyse data in real time — and it is
100 percent compatible with your Raspberry Shake.
This is professional open-source software written by
scientists working in volcanology and seismology.
Download the software here: magpi.cc/2t3ydp2.

Improve your data quality

Use the levelling feet and bubble level on Raspberry
Shake’s custom enclosures to make sure your
device is completely level: magpi.cc/2t3PY7w.

The enclosure design reduces ambient noise while
allowing you to see the Earth’s movement. It should
even detect your washing machine’s spin cycle!

Tutorial

The
Raspberry
Shake board
converts the
analogue
signal from
the geophone
into a digital
signal, and
works with
the Raspberry
Pi to process
the data for
you to view
and analyse

USE 'IF THIS

THEN THAT'
IFA_%RATION
(IFTTT)

MAKE YOU
OWN CUSTOM
E

ENCLOSUR
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Tutorial

> Raspberry Pi
Zero W

> USB-A to micro
USB-B cable
(plus an optional
extra cable
you don't mind
modifying)

DAVE HONESS

Dave is the programme manager
for Astro Pi, and the Foundation's
resident space geek.

magpi.cc/2tgs5eza

Watch compatible files on
your TV using the Pi Zero W
as a USB storage device

Power the Pi Zero from
the TV or via a separate
power source

PI ZERO W
PEN DRIVE

Wirelessly send files to a USB pen drive inserted into your TV,
milling machine, or lathe using a Pi Zero W in USB device mode!

uilt-in wireless on the Pi Zero W opens up a

huge number of possibilities for the various

USB gadget modes. The Pi Zero W can be
configured to spoof different USB device types, such
as a keyboard, a webcam, or a USB pen drive. At home,
many people use a USB pen drive to transfer files to
a TV, but it takes time to move the drive to and from
the source computer. How about a remotely accessible
USB pen drive, permanently located in the TV, where
you could transfer files using the wireless connection?
Drag and drop, job done!

Get on the wireless

On Raspbian Jessie, wireless connections can be made
via the networking icon on the right-hand end of the
desktop menu bar. Left-clicking the icon will bring
up a list of available networks. If you see the scanning
message, wait for a moment and it should find

your network.
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Click the network that you want to join. If the
network is secured, you will see a dialogue box. Enter
the password, click OK, and wait for a few seconds.
Finally, write down the IP address the Pi has acquired.
Hover the mouse over the signal strength icon and the
IP address will appear in a tooltip. If you prefer, you can
complete this process on another Pi, and move the SD
card over to the Pi Zero W when you reach Step 03.

Disable desktop and enable SSH
From this point we don’t need the desktop, because
the Pi Zero is going to have one job: to be a file server
for the TV. To save CPU cycles, we should disable the
automatic boot to desktop. Go to Menu (Raspberry
icon at the top-left corner of the screen) > Preferences
> Raspberry Pi Configuration.

On the System tab, find the Boot option. Select ‘To
CLI’ (command line interface), and disable the ‘Login
as user pi’ checkbox.
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On the Interfaces tab, make sure that SSH is
enabled. Click OK and choose Yes to reboot. After
the reboot, you should see a text login prompt with
a flashing cursor.

Switch to remote access
We recommend using SSH (Secure Shell), because we’ll
be doing everything using the command line. SSH
allows us to see the Raspberry Pi command prompt in
awindow on another PC; Mac, smartphone, or tablet.
Go to magpi.cc/2sLgBmM and follow the
instructions for the platform you’re using. You’ll
need the IP address you wrote down earlier, and the
login. The default login for Raspbian is pi, with the
password raspberry.
When the SSH link is working, you can disconnect
any keyboard and screen.

Free up some disk space

When you’ve logged in over SSH, you can free up disk
space by removing some programs that we’re not
going to need for this project.

The command df -h shows your disk space usage.
Look at the Avail column for /dev/root to see how
much free space you have. We can claw back about 1GB
if we remove LibreOffice and Wolfram.

Enter the commands below into your SSH client:

sudo apt-get remove --purge libreoffice* -y

You can safely ignore any errors you see here. They
happen because the command will try to remove some
parts of LibreOffice that aren’t actually installed.

sudo apt-get
sudo apt-get
sudo apt-get

purge wolfram-engine -y
clean
autoremove -y

Now run df -hagain and check the Avail column.

Enable the USB driver
Next, we need to enable the USB driver which provides
the gadget modes, by editing two configuration files.
sudo nano /boot/config.txt

Scroll to the bottom and append the line below:

dtoverlay=dwc2

Press CTRL+O followed by ENTER to save, and then
CTRL+X to quit.

sudo nano /etc/modules
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Tutorial

Use a modified

cable to keep the

Pi Zero W powered,
even when the TV

is switched off

Append the line below, just after the i2c-dev line:
dwc2

Press CTRL+O followed by ENTER to save, and then
CTRL+X to quit.
Now shut down the Pi Zero W with the command:

sudo halt

Switch to TV power

On the Pi Zero W, you’ll see two micro USB ports.
One is marked ‘USB’ and the other ‘PWR IN’. You can
supply power through either port, but the USB port is
for data as well. There are two options.

You could plug the TV into the Pi Zero W USB port,
not the PWR IN port, using a standard micro USB cable.
The cable will both supply power from the TV and make
the USB data connection. The disadvantage is that
the TV must be switched on to supply power to the Pi.
When someone turns the TV off with the remote, the Pi
will also lose power, which can corrupt your SD card.

Alternatively, you can connect a separate, always-
on power supply to the PWR IN port, and use a slightly
modified micro USB cable to connect the TV to the
USB port. The modification is to cut the red wire
inside the micro USB cable. This protects the Pi from
damage that could be caused by drawing power from
two different power sources. The advantage of this
method is that the Pi is powered independently from
the TV. It will be available on the network even if the
TV is off, and there is a reduced risk of sudden power
loss and SD card corruption.

You might want to test the system with the first
option, and then move onto the second when you
want a more permanent setup. Don’t forget to cut the
red wire if you use the second option.

Connect the Pi Zero W USB port to the TV using your
chosen method, power everything up, and log back in
over SSH.
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Create a container file
To enable mass storage device mode, we need to create
a large file to act as the storage medium on the SD card.

This file will emulate the USB pen drive that the TV sees.

The command below will create an empty 2GB
binary file (change the count=2048 parameter if you
want a different size). Please note that this will be
limited by the available free space on your SD card
(check the Avail column in df -h), and it may take a
few minutes to complete the setup:

sudo dd bs=1M if=/dev/zero of=/piusb.bin
count=2048

We now need to format the file as a FAT32 file
system so that the TV can understand it. Enter the

command below:

sudo mkdosfs /piusb.bin -F 32 -I

Mount the container file

Now let’s mount the container file locally so we can
download some test files. First, create a folder on
which we can mount the file system:

sudo mkdir /mnt/usb_share

Now let’s add this to fstab, the configuration file
that records our available disk partitions:

sudo nano /etc/fstab
Append the line below to the end of the file:

/piusb.bin /mnt/usb_share vfat

users,umask=000 () 2

automatically at boot time. Instead of rebooting, we
can manually reload fstab with the command below:

sudo mount -a

Download a test file

Now let’s download a 300MB test file to view on the TV.
Big Buck Bunny is a short open-source film, made by the
Blender Foundation (www.blender.org), and released
under the Creative Commons Attribution License 3.0:

cd /mnt/usb_share

wget http://download.blender.org/peach/
bigbuckbunny_movies/big buck_bunny_720p_
surround.avi

You’ll see a progress bar move from left to right.
When the download is complete, run a command to
flush any cached data to the disk:

sync

Test mass storage device mode

Now comes the moment of truth. Let’s see whether
the TV is going to be friends with the Pi Zero W. The
command below will enable USB mass storage device
mode, and the TV should pop up a dialogue box. If

it doesn’t, you may need to use the Input or Source
button on the TV remote to select the USB device.

sudo modprobe g mass_storage file=/piusb.
bin stall=0 ro=1

The TV should provide a file browsing interface.
Locate the Big Buck Bunny file and hit Play.
Once you’re satisfied that all is well, try a dismount:

Press CTRL+O followed by ENTER to save, and then
CTRL+X to quit.

The line we added to fstab allows the USB
file system to be error-checked and mounted

Connect to
the Pi Zero W over
the network using

Samba for easy
file transfers

sudo modprobe -r g_mass_storage

The correct behaviour here is for the film or
browsing interface to disappear from the screen.
You may see a message saying that the USB device
was disconnected.

Install and configure Samba
The next step is to provide network access to the
/mnt/usb_share folder that we created earlier.

sudo apt-get update
sudo apt-get install samba winbind -y

When the installation is complete, we need to
configure a Samba network share. For simplicity,
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this will not require a user name or password, as it is
already protected by your wireless network security. If
you want more security, see wiki.samba.org.

sudo nano /etc/samba/smb.conf

Scroll down to the end of the file and append the
lines below:

[usb]

browseable = yes

path = /mnt/usb_share
guest ok = yes

read only = no

create mask = 777

Press CTRL+O followed by ENTER to save, and then
CTRL+X to quit.

Now restart the Samba service for the changes to
take effect:

sudo systemctl restart smbd.service

Access the share from another computer

Now we can try to access the share from a Windows PC
or a Mac. You’ll need the host name the Raspberry Pi
is using. To check this, enter the command below:

cat /etc/hostname

By default this will be raspberrypi.

In Windows, you can bring up Explorer (Windows
key + E) and type \\raspberrypi into the address
bar at the top. The Run dialogue also works
(Windows key + R).

On macOS, the Raspberry Pi will show up in the
Finder sidebar. Alternatively, from the Finder menu,
select Go > Connect to server (Apple key + K) and type
smb://raspberrypi as the server address.

Depending on your network settings, you may still
see a login dialogue. Any user name, including a guest
or anonymous login, will work. Once you’re in, you’ll
see a share named usb. Open this and test that you
have write access, either by creating a new folder or by
copying over a file.

You can enable mass storage device mode to check
that the TV can see your changes, but don’t forget to
run the sync command first.

If you want to change the host name, edit the name
in fetc/hostname. Make the same change in /etc/hosts,
and finally use sudo reboot to apply the changes.

Automate USB device reconnect
In order for the TV to detect any changes we’ve made
over the network (for example, file or folder creations

raspberrypi.org/magpi
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and deletions), it needs to be tricked into thinking
that the USB device has been removed and reinserted.

We can use a Python library called watchdog
(magpi.cc/2sLL1fi), which is designed for monitoring
file system events and responding to them. Install
this with the command below:

sudo pip3 install watchdog

We then need some code to start a timer whenever
something changes in the shared folder. The timer is
reset to zero every time a new change occurs, and the
USB reconnect is only triggered if we see 30 seconds
of inactivity after a change. This avoids spamming the
TV while we’re copying over multiple files.

We’ve written a program to do this. To
download it, type:

cd /usr/local/share
sudo wget http://rpf.io/usbzw -0 usb_share.py
sudo chmod +x usb_share.py

Background service

We need to make this program into a background
service, so that it starts automatically at boot time. We
can do that by making it into a systemd unit. Enter
the commands below:

cd /etc/systemd/system
sudo nano usbshare.service

This will start a new blank file. In the new file, enter:

[Unit]
Description=USB Share Watchdog

[Service]

Type=simple
ExecStart=/usr/local/share/usb_share.py
Restart=always

[Install]
WantedBy=multi-user.target

Press CTRL+O followed by ENTER to save, and then
CTRL+X to quit.

Now we need to register the service, enable it, and
set it running:

sudo systemctl daemon-reload
sudo systemctl enable usbshare.service
sudo systemctl start usbshare.service

Whenever you copy files over to the network share,

the USB device should automatically reconnect to the
TV after 30 seconds of inactivity.
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SANJEET CHATTERJEE

15-year-old technology enthusiast and
self-taught programmer with a knack
for creativity. Passionate about studying
robotics and Al.

magpi.cc/2t30JtK

SiriControl fetches the
commands from your Gmail
account, and runs the
appropriate module

Siri creates a note with your
command, which syncs with
your Gmail account

CONTROL YOUR PI WITH SIRI

SiriControl is a framework, written in Python, which implements
an ingenious hack to enable you to add Siri voice control to any project

> iOS device

> SiriControl:
magpi.cc/
2t3Bhgv

iri is an intelligent personal assistant,

integrated with Apple devices. From setting

reminders to hailing taxis, Siri can do many
things to make life easier. However, wouldn’t it be
awesome if you could control anything with Siri?

Welcome to SiriControl — a Python framework

which provides a simple way of using Siri voice
commands to add fantastic voice control to any
project. The possibilities for SiriControl are endless,
and as no extra hardware is required: you can get
started right away!

You will need to add your Gmail account so that the Notes can be synced with it

58 | MdgPi August 2017

How it works

Siri can create Notes by using the command word
‘note’. The new Note is then synced with the linked
Gmail account. SiriControl fetches the new Note from
the Gmail account, and executes the appropriate
function from the dynamically loaded modules created
by the user. This ingenious hack enables you to add
fantastic voice control capabilities to any project,

with minimal setup required.

Configure Gmail

A Gmail account is required for SiriControl. For
security reasons, we suggest creating a new Gmail
account specifically for SiriControl, as you will have to
enter your credentials in a Python script.

Access for less secure apps needs to be enabled for
your new account as Google identifies the connection
between the Python script and mail servers as less
secure — see magpi.cc/2u3gprx.

IMAP must also be enabled. This is found in the Gmail
account settings, as shown in the image (on next page).
This is the protocol SiriControl uses to fetch new Notes.

raspberrypi.org/magpi



Prepare your i0S device
The Notes need to be synced with your Gmail account
so that SiriControl can fetch the voice commands that
you say, through Siri. So navigate to Settings > Notes
> Accounts > Add Account on your iOS device, and add
your new Gmail account.

After turning on Notes, ensure that the default
account for creating Notes is the new account.
Now, if you say to Siri, “Note this is awesome,”
it should appear under the Notes section, under your
Gmail account.

Set up SiriControl
Finally, you will need to clone the SiriControl
repository using:

sudo apt-get update
sudo apt-get install git-core

git clone https://github.com/
theraspberryguy/SiriControl-System

Edit siricontrol.py and enter your Gmail account
credentials. This should be self-explanatory once the
script is opened up.

Next, run siricontrol.py and say to Siri: “Note
meaning of life.”

You should get the answer. That’s it! You have
finished the SiriControl setup. Now, let’s add your
own voice commands.

Create your own modules

SiriControl uses a modular approach for adding your
own commands. Each voice command, along with its
action, is separated into different modules, found in
the modules folder.

Every module must have the following:

moduleName - this is the name of the module,
which can be anything you want.

commandWords — this array will contain the words
which need to be spoken in order to call the
execute() function.

execute(command) — this function is called when
all the words in the commandWords array are spoken.
The command parameter is the complete command
spoken by the user.

Take a look at the life.py module, which comes

with SiriControl, to gain a better understanding of
how it works. Also, keep in mind that all modules you
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life.py

#You can import any required modules here
DOWNLOAD:

moduleName =
commandWords = [ , ]

def (command) :
print("\n")
print(
print("\n")

IMAP must
be enabled so
that SiriControl
can fetch the
new Notes using
this protocol

magpi.cc/2t3BAwb

Access for less
secure apps needs

to be enabled, as
Google identifies

this connection as

. . being less secure
create must be stored in the modules directory for

SiriControl to load when it starts up. The template
Module.py is also included with SiriControl, which
can be used as a reference.

Next steps

Now you know how to create your own voice
commands, what next? Well, whether it’s as simple

as turning on an LED or controlling your TV using
infrared signals — with the power of Siri behind it,

the possibilities are endless! You could integrate
SiriControl into any project. Due to the nature of

the hack, you can control your Raspberry Pi from
anywhere in the world, as long as you have an internet
connection. This opens up many possibilities, including
home automation and IoT. Anything is possible!
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PIO ZERO

GPIO Zero is a very powerful tool, and now you can use it
when you’re not even on the Raspberry Pi!

he GPIO Zero Python library not only makes

programming simple electronics easier; it

comes with some advanced features. These offer
seamless interfacing between different devices, while
helping you progress along the Python learning curve.
One useful thing about GPIO Zero is that you can choose
which low-level pin library to use, allowing you to take
advantage of the power of another library as required,
without having to rewrite your code. By default, Ben
Croston’s RPi.GPIO library is used, and that’s fine
for most purposes. One of the supported alternative
libraries is Joan 2937’s pigpio library, which supports
remote GPIO. This allows you to remotely control the
GPIO pins of a Pi over a network. You can control the
pins from a PC or Mac, or from another Pi, and even use
the GPIOs of multiple Pis within the same script.

This month, GPIO Zero v1.4 was released, stabilising

the remote pins syntax. This guide is written for vi.4 and
will not work on earlier versions. Make sure you upgrade

Ben road-
tested remote
GPIO using
Traffic HATs in
a workshop

at the Pi
Towers Jam

You can
control one
Pi's GPIO pins
from another
Pi using the
new tools
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before you start: open a Terminal and enter sudo apt
update && sudo apt install python3-gpiozero.
A simple GPIO Zero Python script looks like this:

from gpiozero import Button, LED
from signal import pause

btn
led

Button(2)
LED(17)

led.source = btn.values
pause()

Running this script on a Pi will work as expected: a
button connected to pin 2 (BCM numbering) will light
an LED connected to pin 17 when pressed. However,
when configured correctly, running this same script
can control the pins of a Pi over the network.

raspberrypi.org/magpi



REMOTELY CONTROL GPIO WITH GPIO ZERO

Learn more advanced

ways of using GPIO Zero
in the documentation

Pin factories
The way GPIO Zero wraps around low-level pin libraries
is by providing a pin factory. By default, an RPi.GPIO-
based factory is used, and when you ask for a pin, the
factory gives you a connection to it using the chosen
pin library. A pigpio pin factory can be used on its own
(simply use the pigpio library instead of RPi.GPIO),
but if an IP address is provided too, this can be used to
remotely control a Pi’s pins.

To run the above script (unchanged) on a remote
Pi, the Pi needs to be configured to accept remote
connections. This can be done using the Raspberry Pi
configuration tool (via GUI or sudo raspi-config), by
enabling Remote GPIO under Interfaces. Otherwise, the
Pineeds to have the pigpio daemon running, by entering
sudo pigpiod ina Terminal. Finally, look up the Pi’s IP
address with hostname -I. Now return to the Piyou’re
running the script from, and instead of running the
code normally (like python3 led_button.py), set two
environment variables in the same command, using the
remote Pi’s IP address:

GPIOZERO_PIN_FACTORY=pigpio
PIGPIO_ADDR=192.168.1.5
python3 led_button.py

Now, when the script runs, the GPIO commands are
executed on the remote Pi over the network.

An alternative to running a script from the command
line is to set the environment variables before launching
your Python editor. For example:

GPIOZERO_PIN_FACTORY=pigpio
PIGPIO_ADDR=192.168.1.5
idle3 &

You can also export these variables in your .bashrc
file. See magpi.cc/2qd2MEDb for more information.

Hot-swapping pin factories

The previous example showed how to set the default
pin factory. Unless otherwise specified, any GPIO
devices created will be connected to pins created by
this default pin factory. Alternatively, you can specify
a pin factory (and with pigpio, an IP address) within
the Python code. There are two options for doing this.

raspberrypi.org/magpi

You can create a pin factory instance, and pass that
in as you create a new object, like so:

from gpiozero import LED, Button

from gpiozero.pins.pigpio import PiGPIOFactory

from signal import pause
factory = PiGPIOFactory('192.168.1.5")

btn
led

Button(2) # local RPi.GPIO pin

led.source = button.values
pause()

Alternatively, you can change the default pin factory
in the middle of your script, like so:

import gpiozero
from gpiozero import LED, Button

from gpiozero.pins.pigpio import PiGPIOFactory

from signal import pause

btn = Button(2) # local RPi.GPIO pin

Tutorial

LED(17, pin_factory=factory) # remote pin

gpiozero.Device.pin_factory = PiGPIOFactory('192.168.1.5")

led = LED(17) # remote pin
led.source = button.values
pause()

Press the button on your Pi and watch the LED light
up on the remote Pi. With no environment variables
set, RPi.GPIO is used as the default pin factory. When
the button is created, it uses RPi.GPIO to address a local
pin. The default pin factory is replaced with pigpio,
connecting to a particular IP address, and the LED is
created on pin 17, which now refers to the remote Pi.

While this can be a confusing concept, it’s quite
simple once you get used to the idea, and it could be very
useful in many projects. You can even run this code on
a PC (not a Raspberry Pi) and use it to control a Pi on
the network. Any platform (Windows, Mac or Linux)
will work, as long as you have Python, pip, GPIO Zero,
and pigpio installed. For full instructions, head over
to rpf.io/remotegpio.

Security
It’s worth pointing out that allowing remote GPIO
connections over the network can be risky. You probably
shouldn’t do this in a real project on a network with
other users. However, you can take precautions to make
it more secure. An easy method is to only allow remote
connections from a particular IP address when launching
the pigpio daemon: sudo pigpiod -n 192.168.1.4.
Check out some remote GPIO recipes and more on the
GPIO Zero documentation at magpi.cc/2qd2MEDb.

LEARN
MORE ABOUT
GPIO ZERO

GPIO Zerois an
amazing tool
for creating
simple
electronics
and making
your projects
just that little
bit easier.
Check out

our Essentials
book, Simple
Electronics with
GPIO Zero, to
learn more:
magpi.cc/
2bA3ZP7.
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ASKED QUESTIONS

The official
Raspberry Pi case

YOUR QUESTIONS ANSWERED

RASPBERRY PI

HOW CAN | KEEP

THE RASPBERRY PI SAFE?

Get a case

The Raspberry Pi is pretty sturdy as a board, but
getting a case makes sure it’s even hardier. A

case will help protect it from dust and accidental
placement on a metal table. Numerous inexpensive
cases are available, including the official versions
(magpi.cc/2tb49Zm) and some fun layered cases
from Pimoroni (magpi.cc/2urDcRn).

Choose a suitable environment

Like a can of beans, you should keep the Raspberry Pi in
a cool, dry place. If you want to place it on a windowsill
in southern California, it will be fine, but it probably
won’t last as long as one kept in the shade.

Turn it off

If you have a Raspberry Pi that doesn’t need to be on
24/7, it may be a good idea to turn it off when you’re not
using it. It draws very little power, so you can keep it on
for long periods of time if you need to.
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NEED A
PROBLEM
SOLVED?

Email magpi@raspberrypi.org or
find us on raspberrypi.org/forums
to feature in a future issue.

HOW CAN | KEEP RASPBIAN

RUNNING SMOOTHLY?

Low maintenance

Unlike Windows, Raspbian should run smoothly all
the time if you’re just using it to do the odd Raspberry
Pi project. Its Linux base runs differently to Windows,
so it doesn’t become ‘bloated’ in the same way.

Uninstall redundant software

If you’ve installed a piece of software for a specific
project that you no longer need, it may be a good idea
to remove it. Some software will add extra background
services to Raspbian, and they’ll grow to take up more
computing resources, especially if it’s an internet-
based project.

Desktop or command line?

Depending on how you use your Raspberry Pi, it may
be useful to set Raspbian to boot to the command
line instead of the desktop. You can change the

boot settings in Menu > Preferences > Raspberry Pi
Configuration, where you can also choose whether or
not to log in automatically.

HOW DO | KEEP MY FILES SAFE?

Cloud storage backup

Keeping your more important files on Dropbox or
another cloud storage service is a good idea. You can set
up Dropbox on Raspbian to sync files, which will also
allow you to access them easily on another computer.

SD card backup

Be sure to make copies of your SD card, especially if
the setup is complex and may need to be replaced
quickly in an emergency. Check our troubleshooting
guide (starting on page 16 of this issue) for
information on how to do this.

Change passwords

Raspbian uses a standard default user name and
password, so if you need to have your Pi open to SSH
and keep your files secret, you’ll want to change

the password. This guide will show you what to do:
magpi.cc/2igmgpO.
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YOUR QUESTIONS ANSWERED

FROM THE RASPBERRY PI FAQ

RASPBERRYPI.ORG/HELP

CAN | BUY A RASPBERRY PI KIT?

Raspberry Pi resellers produce some fantastic

bundles for people who would rather get everything
they need from a single source. Last year, The
Raspberry Pi Foundation put together an Official Starter
Kit. The kit is available to order online in the UK from

its partners, element14 (magpi.cc/2cCT8pk) and RS
Components (magpi.cc/2nrY33i), priced at £99+VAT,
and from distributors and resellers around the world.

IS THERE A BUY-ONE-GIVE-ONE PROGRAMME?

Not at the current time. Raspberry Pi may implement
a gifting programme one day, but at the moment the
Foundation’'s small team isn't equipped to handle the
scale of an undertaking like this. You can, of course,
simply buy an extra Raspberry Pi to donate to the
person or organisation of your choice.

IS THE DEVICE AVAILABLE INTERNATIONALLY?
Yes. Take a look at the official resellers that
ship internationally, or check out your local big
electronics chain.

I WANT TO BE A RASPBERRY PI RESELLER

Raspberry Pi has an exclusive manufacturing and
distribution arrangement with RS and Farnell. Resellers buy
the Raspberry Pi in bulk from them (which reduces shipping
costs to nearly nothing) and sell them on. You do not need
any special licence to resell, and the distributors are very
happy to sell on to resellers. Unfortunately, because of

the way the pricing model works, and the fact that the
Foundation is a charity, you will have to buy in very large
quantities before you will qualify for any bulk discount.
What most resellers are doing is using the resale process
as a way to sell high-margin peripherals and add-ons.
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Teature

he Raspberry Pi is beloved

by artists and seriously

creative people. These
digital makers are building the
future, but they’re also building
superb works of art. In galleries
around the world, you’ll find
Raspberry Pis quietly tucked away
inside incredible art installations.
The small size and low power
usage of the Pi make it ideal for
public installations. Raspberry
Piboards can control movement,
light, sound, and vision. Just as
importantly, they can provide a
layer of interaction between the
audience and the artwork.

Raspberry Pi-powered art is

often more interesting to the
public because they can interact
with it on their own terms. The
results are some of the most
creative projects on Earth. We’ve
featured a lot of artistic projects
in The MagPi, mostly because they
show off some creative use of the
common technologies applied by
digital makers.
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In this feature we’ll look at
some common techniques used by
artists incorporating a Raspberry
Piinto an installation. Learning
these techniques can help you
to integrate a Raspberry Pi into
your project. Even if you don’t
see yourself as an artist, creating
something is a great way to learn
about a particular feature or
element of the Raspberry Pi.

The intersection of visual art
and technology is one of the most
exciting places to be, and the
Raspberry Pi is right at that point.
Let’s look closer at Raspberry Pi art
to see what we can make.
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You can connect a wide range of
sensors and input devices to the
GPIO pins, and also use them to
control motors and LED strips.
TORUS is a music installation piece
created by Dutch visual
artists Ridwan Nasruddin
and Guust van Uden
(magpi.cc/2aWdyge).
Itis alarge

geometric shape,
covered in hundreds
of LEDs, controlled

by a Raspberry Pi.

Cacniera SMadule

The built-in connection for the Camera
Module makes it easy to add still
photography and video recording
using a Raspberry Pi. The Trophy
Camera project (magpi.cc/2t6ZiZn)

is a great example of an art installation
that uses the Camera Module. Visitors
to the Tetem gallery in The
Netherlands use it to
take photographs,
which are then
deemed award-
worthy (or not)
thanks to its

Al intelligence
algorithm.

TtOINI videa

The HDMI socket enables you to
stream 1080p video at 60 fps. You
can also connect an official Pi 7-inch
touchscreen to the DSI port.
It's easy to add video to
your creative Pi projects.
The #GMPiWall

video installation
(magpi.cc/2tiSxPr)
uses old TV sets
retrofitted with Pis. Built
by Joseph Hazelwood,
#GMPiWall appeared at the
Oz Arts Fest.

raspberrypi.org/magpi

GETCREATIVE  Teature

Uireleaa and Ethernet
&e

The built-in Ethernet and wireless

networking connection can be used

to link your creation to the internet

for interesting data-driven artworks.

Cory Guynn's Internet of LEGO project

(internetoflego.com) is a giant LEGO

sculpture connected to the Transport for

London AP, recreating the commuter world
on a smallscale.

7ludia aut
The 3.5 mm audio jack can be used to
output sound from the Raspberry Pi.
Oryou can add a DAC (digital
to analogue converter)
board for higher-
quality audio.
Lichen Beacons
(magpi.cc/
2tPnw7t) is an
interactive sound
installation that
uses portable
Raspberry Pi and
Bluetooth beacons to
play music and poetry as
visitors walk around an attraction.
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Raspberry Pi can give

you the opportunity to

explore participation
and interaction in your digital
creations. The Raspberry Pi makes
it easy to add video and sound
to a creative space, and you can
connect this up with sensors and
interactive elements, such as
buttons or controls. This setup
lends your artistic experiment a
much greater level of engagement
with the audience.

Loop video

Probably the first skill you want to
learn is how to loop video. Raspbian
comes with Omxplayer, which can

MdagPi August 2017

play video from the command line.

It also features a handy loop option.

omxplayer -b --loop --no-osd
video.mp4

This will play the video
repeatedly on a blank background,
and remove the on-screen display
(which by default shows the play
time on the screen).

You can also run the video at
startup, so it plays as soon as you
plug in the Raspberry Pi. A quick
hack is to add a command to
.bashrc in your home folder.

nano .bashrc

Add:

omxplayer -b --loop --no-osd
/home/pi/video.mp4

...to the end of .bashrc (replacing
‘video’ with the name of your file).
Save and reboot. Note that this

will boot automatically and you
won’t be able to get out of the
video. Pressing ALT+F1 will enable
you to open another command-
line shell, where you can edit or
remove the line from .bashrc.

It’s also a good idea to enable
SSH and ensure that you can access
your Raspberry Pi remotely when
running looping video. A much
more detailed, and effective, script
can be found on the Raspberry Pi
forum (magpi.cc/2uJiu)z).

Loop still images

The best way to loop still images
on a Raspberry Pi is to use a
screensaver. You’ll need to
install one first, using two apps:
feh and XScreenSaver.

sudo apt-get update && sudo
apt-get upgrade

sudo apt-get install feh
xscreensaver
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From the Raspbian desktop
Menu (top left), select Preferences
> Screensaver and set Blank After
to 720 minutes. This will allow the
screensaver to run for 12 hours.
Place all your image files in a
directory called media in the home
directory and run this command:

feh -Y -x -F -Z -q -B black
-D 10 /home/pi/media

The -B option changes the
background colour, while -D sets
the length (in seconds) before the
next slide.

Playing audio
You can play audio on a Raspberry
Pi using Omxplayer:

omxplayer example.mp3

If you need an example file,
you can download one with
this command:

wget https:@goo.gl/XJuOUW
-0 example.mp3 --no-check-
certificate

You can force output to the
HDMI socket or headphone jack
using the -o option:

-0 hdmi
-0 local

Use --1oop to loop the audio
and --no-osd to remove the
on-screen display.

omxplayer -o local --loop
--no-osd example.mp3

The Trophy artwork installation uses a Raspberry Pi

and Camera Module with Al technology. Visitors try to
capture award-winning photographs using the camera
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Live-coding synth
Raspbian comes with a live-coding
synth program called Sonic Pi
(sonic-pi.net). With Sonic Pi you
can code original synth scores, and
there’s a huge range of samples.
It’s particularly good for creating
ambient sound effects (everything
from haunted bells to Tron bikes).

There’s more to Sonic Pi than we
can cover here, but make sure you
pick up a copy of Code Music with
Sonic Pi (see sidebar).

Add interaction

Adding interaction to a piece is
the reason many artists pick up a
Raspberry Pi in the first place.

Wiring up buttons and sensors to
a Raspberry Pi couldn’t be easier.
You can use a breadboard to test out
your electronics, and then solder
the circuit into your creation. It’s
a big topic, but the process is a
lot easier than you think. See our
Simple Electronics with GPIO Zero book
in the sidebar for details on how to
get started.

You can also use the GPIO pins
to control LED strips, such as
Blinkt! (magpi.cc/2uRAXnp).
These add high-tech colour to a
creative project.

Don’t forget that Raspberry Pi
makes an official touchscreen
(magpi.cc/2ufft6Y). This can be
used to add a small display to your
creations, which observers can push
and touch. With a bit of coding,
you can create your own interface
(see Getting Started with GUIs in The
MagPi #58, magpi.cc/2t6979S).

Motion control

In our Simple Electronics with GPIO
Zero book, you’ll also find detailed
info on using servos and motors.
These make it possible to add
movement to your creative projects.

Servos are special motors that
drive precise circular movements.
The rotating parts can be extended
to create clock-like precision
elements or limb-like gestures.

DC motors provide continuous
circular motion. They can be used to
add fans, wheels, or other rotating
elements to your creative project.

Teature

Cameras

The Raspberry Pi Camera Module

is a good addition to some projects.
It enables you to capture stills and
video, which can become part of the
artistic project, or shared online.
Take a look at the Photo Booth
project on page 30.

The Trophy Camera featured in
The MagPi #58 (magpi.cc/2t6yKay)
is a great example of an installation
that uses the Camera Module.
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rocessing is an open-

source development

environment and
programming language, designed
for learning to code. While it is very
flexible and powerful, it is mainly
used in the realm of visual arts.

Processing allows you to use
code to create drawings on screen.
The language is certainly capable
of much more than that, but this
tutorial will focus on drawing.

To install Processing, visit
processing.org/download and
download the Linux ARMv6hf
version. Enter this in the Terminal:

tar xvfz processing-3.3.5-
linux-armvéhf.tgz

cd processing-3.3.5/

sudo ./install.sh

To start Processing, click on Menu
> Programming > Processing. The
main Processing window is where
you’ll type your code, and the Run
button is how you’ll execute that
code. In the world of Processing, the
program you write is called a sketch.
To create your first simple sketch,
enter the following code:

line(0, @, 100, 100);

Now click Run. A new window
should appear, showing a box and
adiagonal line. The line function
draws a line between two points in
the window. It takes four inputs: x1
and y1 for the start of the line, and
x2 and y2 for the end of the line. The
syntax for the line function is:
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line(x1, y1, x2, y2);

The numbering begins at 0, not 1.
Also, the origin is in the top-left,
rather than the bottom-left. See
Figure 1.

You can do a lot with lines,
but Processing can draw plenty
of different shapes. Enter the
following code in a blank sketch
and press Run:

ellipse(50, 15, 30, 30);
The ellipse function draws an

ellipse (oval). An ellipse with equal
width and height is more commonly

Fop 14

known as a circle. The syntax for the
ellipse function is:

ellipse(xPosition,
yPosition, width, height);

Try using the 1line function to
draw the rest of a person. Here’s a

hint to get you started:

ellipse(50, 15, 30, 30);

Figure 1

line(50, 30, 50, 70);

You can draw a rectangle using
four 1ine() commands, but there’s
a rectangle function, rect, to make
it easier. Its syntax is:

rect(xPosition, yPosition,
width, height);

Try drawing a box around your
stick figure. At this stage, it’s
important to note that as your
code is executed, Processing draws
shapes on top of previously drawn
shapes. You may want to execute the
rect function before the code that
draws your stick figure.
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The program is packed with examples of quirky artworks
based on fractals, waves, and other scientific concepts

Add colour to
your shapes
There are many ways for us to
describe colours to a computer.
With Processing, you’ll usually
use an RGB value, which describes
colours by stating how much red,
green, and blue are in them.

To try it out, run the following
code to draw a circle with a red fill:

fill(255, @, 0);
ellipse(50, 50, 75, 75);

After you call the fill function,
any shapes drawn after that
function will have that colour fill,
until you call the fill function
again with a different colour. The
syntax for fill is:

fill(red, green, blue);

Each primary colour can be
given a value of 0 to 255. 0 means
no presence of the colour, and
255 is the maximum amount of
that colour.

To change the colour of the
outline, use the stroke function. It
uses the same colour parameters as
the £i11 function:

stroke(red, green, blue);

If you want to get rid of the
stroke or fill, use the noStroke and
noFill functions. Keep in mind
that if you use them both at the
same time, you won’t be able to see
what you’re drawing!
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By default, all lines are one pixel
wide. To increase the thickness of
the line, use the strokeWeight
function. As with the colour
functions, after you call it, all the
shapes you draw will have your
specified thickness until noStroke
is called, or strokeWeight is called
with a different value. The syntax is:

strokeWeight(width);

Respond to input

To create movement, you’ll need to
define two special functions: setup
and draw. The code you write in the

o T4

setup function is only executed
once, when your sketch starts.
Afterwards, the code in the draw
function is executed over and over
again until you terminate the sketch.
This is the basic structure of most of
the Processing sketches you’ll write:

void setup() {
@ the code here will
only be executed once.

}

Teature

GET CREATIVE

void draw() {
@ the code here will

be executed over and over DOWNLOAD:
aga in. magpi.cc/ picreative
}

Enter the code from circle.pde
into a new Processing sketch and
run it. The pieces of text after the
double slashes are comments to
help you understand what each
line is doing; they’ll be ignored
by Processing.

You should see a circle moving
downwards. When it gets to the
bottom, it resets to the top again. It
will move like this forever.

The code in processing.pde
uses a few special variables that
all Processing sketches have built
in: height, width, mouseX, and
mouseY. The height and width
variables refer to the height and
width of the window. The mouseX
and mouseY variables contain the
position of the mouse pointer.

You also used the height variable
in the previous sketch, to check the
position of the circle in relation to
the bottom of the window.

The code also creates a special
function called mousePressed()
that is executed when either
mouse button is pressed.

This is an example of ‘event-
driven programming’.

These are just the basics of
drawing on screen using code; there
are many more functions to try.

You can see a list of functions in the
Reference section at processing.org.

Processing can be used to create animated and interactive
artwork, like our balls that respond to mouse presses
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Draw lines in the sand with a
robot-controlled magnet

The kinetic sculptures are drawn in
sand by Sisbot, a robot with two DC
motors that sits under the table

Bruce Shapiro is a maker and an artist.
Unlike Picasso or Rembrandt, Bruce
doesn't paint with oil and brushes. "My
medium is motion control,” he told us
in The MagPi #52 (magpi.cc/2tPgSi14).

“In Greek mythology, Sisyphus
was condemned to roll a boulder
up a mountain for all eternity,” says
Bruce. “In my art, Sisyphus is a kinetic
sculpture that rolls a ball through sand,
forever creating and erasing beautiful
patterns. Watching Sisyphus evokes a
meditative feeling.”

Under the table is a two-motor robot
called Sisbot. This moves a magnet
which pulls the steel ball (sitting above
the sand). The motors of the Sisyphus
are controlled by a Raspberry Pi. This
plays a set of path files, much as a
music player plays an MP3 file.

At the lowest level, the Sisbot
is controlled by “firmware written
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in C, running on the SisBotBoard".

This was created by Brian Schmalz
(magpi.cc/2t74z37) for an earlier
project Bruce created called EggBot.
“Brian started many years ago with the
initial crude C code | wrote for running
my steppers,” Bruce explains.

The second levelis higher-level
motion control, recently ported to
JavaScript by Bruce and cleaned up
considerably by Alex Wayne. This code
runs in Node js on the Raspberry Pi.

The third levelis algorithmic path
generation. “l originally did this by
writing using AutoLISP routines running
in vintage AutoCAD," says Bruce, “but
now | use Grasshopper Rhino 3D."

Above The Sisbot works like a CNC cutter,
moving the magnet around in circles
while the arm moves up and down

Digital Laetrafe

Learn how to integrate displays
into your creations with this
unique high-tech recreation of
a design classic

Brian Corteil's Digital Zoetrope
replaces the photos on the inside
with 12 OLED displays. Like a classic
zoetrope, you spin it around by hand
and look through the slats to see
movement in the stillimages as they
rotate. It can project stillimages to
create a classic 12-frame short, or
update the frames in real time to
produce a longer movie.

It's a good example of incorporating
digital images into a project, and
ranked #27 in our readers’ Top 50
projects of all time. You can read
more about it in The MagPi #50
(magpi.cc/2t6Rvul).
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SeeMare

A moving
Raspberry

Pi sculpture
that's
secretlya
supercomputer

Virginia Tech's
SeeMore uses
256 Raspberry Pi
boards to create
a massive fusion
of techand art.
It was designed
to inspire a sense of the beauty of
parallel computing.

A lot of the parts were custom-
made via CNC and laser etching,
so there's a lot you can learn about
electronic sculptures with SeeMore.
But the coolest thing about the
piece is how the panels covering
each Pi move depending on how
much computational power is being
used. These are moved using servo
motors, so it's an inspirational way to
add gentle movement to a project,
controlled by a data point.

SeeMore came second in our

readers’ Top 50 (magpi.cc/2t6qOpH).
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Discover
interactivity

by following
Voyage's lead

Voyage is an

impressive art
installation

that's toured the

world, appearing

in London and

Salford Quays in the UK.

Conceived by Newcastle-based
studio Aether & Hemera, the art
project is made from coloured paper
boats floating on water.

There's a Raspberry Pi acting as a
DHCP and web server as part of the
control mechanism, and it's a great
example of how you can add public
interaction to a project. Viewers
engage with the lights from their
mobile phones.

QBee

Add LED lighting to a project

Clodagh O'Mahony designed a
wearable connected platform that
is a comment on the progression of
social media interaction. The QBee

Teature

dress incorporates an Adafruit 12-key

capacitive touch sensor breakout
board, Pimoroni Blinkt! fibre optics,
and a Raspberry Pi, all fitted inside
a hexagonal 3D-printed casing. The
fibre optics are woven throughout
the dress.

The QBee dress features touch-sensitive pads and has
LED fibre optics woven into the fabric
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GOPIGO3

Maker
Says
A
complete
kit to build
your own

robot car
Dexter Industries

CORETEC
TINY 4WD

With twice as
many wheels
for around half
the price, this
new Pi Zero W
based robot is
a capable rover.

£55 / $70
magpi.cc/2r8e70S

GOPIGO3

Sturdy robot kit creates a network and broadcasts lessons,
making it ideal for students and teachers alike

or the last couple of years,
the GoPiGo has been one of
the most impressive robot
kits available for the Raspberry Pi.

The build remains excellent for
the latest version. Two 3D-printed
acrylic boards house a Raspberry
Pi 3 and GoPiGo3 board. To this,
you attach the motors, a wireless
networking dongle, a battery pack,
and a USB thumb drive.

The build of the robot is relatively
complex (although with fewer steps
than the GoPiGoz2 kit it replaces).

It took us 45 minutes to put in all
the screws, washers, and posts that
connect the various parts together.
This build time is about three times
as long as most kits we encounter.

There are good photographic
instructions, though, and we
didn’t get stuck during the build
process. More information on
the build process can be found
at magpi.cc/2vo8oVo.
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You might be wondering why it
comes with a wireless dongle when
the Raspberry Pi 3 has wireless
built in. That’s because GoPiGo3
broadcasts its own wireless
hotspot, so the minute you switch
it on, you can connect to it via a
local network called GoPiGo.

Thanks to this approach, as
soon as you’ve finished the setup
and inserted the eight batteries,
it becomes an absolute breeze to
start using the GoPiGo3. There’s
a whole new DexterOS operating
system to play with and it’s packed
with features.

Hotspot robot

The robot transmits its network
called GoPiGo. You connect to this
network, and point a web browser
to bloxter.com. You don’t need
internet access to do this. You

can log into the network from a
Windows, Mac, or Linux computer;,

a tablet or smartphone; and of
course, another Raspberry Pi.

The web interface starts with
four options: Drive, Learn, Code
in Bloxter, and Code in Python.
Click Drive and you can move
the robot around using the on-
screen buttons. Tap Code in
Bloxter and you can use Scratch-
style blocks to control the robot.
The Code in Python option lets
you use a web-based Python
IDE to program the robot with
the GoPiGo3 software library
(GitHub, magpi.cc/2tWzmwE).

You can use Scratch to control
the GoPiGo, but you need to
switch the OS over to Raspbian for
Robots. We think DexterOS has the
better solution with Bloxter and
Python. Based on Google Blocky
(magpi.cc/2uq6MG9), Bloxter is
similar enough to Scratch.

On the whole, DexterOS is a
slick solution that enables you to
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start controlling and programming
the robot quickly. Perhaps

more importantly, it combines

the lessons and programming
environment into one single space
that doesn’t require an internet
connection — the robot acts as a
router. There are dozens of lessons
covering movement, sensors,
speakers, buzzers, and buttons.

Ready to teach
There’s a lot here for teachers.
The GoPiGo is a great tool
for introducing robotics to a
classroom. It’s relatively easy to
set up, very easy to connect to
from a wide range of computers,
network independent, and packed
full of tutorials for visual and text-
based programming environments.
The two motors have encoders
built in, so you no longer have to
attach these separately during the
build. These act as tachometers,
measuring the precise rotation
of the wheels. The GoPiGo3 runs
forward and backwards in a
straight line, can move by precise
amounts (such as 10 cm or 5 in),
and turn with degree precision. It’s
a small thing that makes a massive
difference to the experience of
using a robot.
There is a GoPiGo base kit for just
$99. It includes the GoPiGo3 board,
chassis, wheels, motors, encoders,
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and power battery pack. You need
to add your own Raspberry Pi 3.

We tested the S199 Starter Kit,
which comes with a Raspberry Pi 3,
mini WiFi dongle, GoPiGo servo
package, distance sensor, microSD
card (with DexterOS software),
8GB USB drive, and power supply.
It’s a useful complete package,
but we think the base kit would be
sufficient if you already have many
of the components.

The 8GB USB drive is used to
update the software. You add
software updates to the USB drive,
power up the GoPiGo robot, and it
automatically updates its software
(see magpi.cc/2t1QO0yr) — again,
without the need to remove the SD
card or connect to a network.

Both kits will be available
soon in the UK from ModMyPi
(magpi.cc/2tTWJgN).

Dexter offers a range of
accessories for the GoPiGo. The
Starter Kit comes with a servo
motor and distance sensor, but you
can also add an ultrasonic distance
sensor, sound sensor, buzzer,
temperature and humidity sensors,
camera, and line follower. You can
find tutorials for each of the sensor
projects at magpi.cc/2vo8oVo.

There’s a lot about this robot that
makes it ideal for the classroom.
Aside from the integrated lessons
and programming environment,

GOPIGO3

it’s a sturdy build. We’d wager it
can take quite a few knocks.

Even if you’re not a student or a
teacher, it’s a great robot kit. The
built-in encoders make it more
accurate than other robots, and
there are plenty of holes on the
board for adding your own custom
equipment. We’ve got a lot of time
for GoPiGo3, and we intend to
spend a lot of time experimenting
with it. Well done Dexter!

last word

One of the best robotics
kits you can buy, especially
for teachers. DexterOS

is delightful, bringing

programming and learning
into one space. Creating its
hotspot frees the robot from
network limitations.

Above Control the
robot's movements
using Bloxter
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FLICK HAT

Maker
Says
Swipe,

tap or flick

your wrist to

control your

Raspberry Pi

Pi Supply

SKYWRITER
HAT

Based on the
same chip

as the Flick,
Pimoroni's

3D gesture-
tracking board
boasts similar
performance.
There's also an
XL breakout
version.

£16 / $21
magpi.cc/10APeHb

FLICK HAT

One of a trio of 3D gesture-tracking boards for Raspberry Pi computers

hat could be cooler than
triggering actions with a
mere wave of your hand?
The Flick HAT allows you do this,
and more. The Flick HAT is one
of three new 3D gesture-tracking
boards — there’s also a smaller Pi
Zero version, and a larger stand-
alone pre-soldered board with
jumper leads to connect it to the
Pi’s GPIO header.
After securing the Flick HAT
to the top of the Pi with the
nylon nuts, bolts and spacers
supplied, and then using a single-
line installer for the software,
it’s ready to use.
It’s a shame there are only three
basic demos supplied, although
a full Python API is in the works.
The first demo shows the X, Y and
Z values as you move your hand
above the board, and it works
best when you use a downward-
pointing finger. While the blurb
claims a vertical range of up to
15 cm, in our tests we typically
achieved 5-7 cm. This distance will
depend on the surroundings, and
how conductive you are.
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Aswell as tracking 3D positions,
the board reads gestures including
swipes (left-right and up-down),
and ‘airwheel’, which involves
rotating your finger in mid-air.
This is ideal for an audio volume
control, as used in the volctrl
demo. Among many other uses,
the swiping actions would be
suitable for controlling a slideshow
presentation — something we
covered back in issue 39 using
the rival Pimoroni Skywriter HAT
(magpi.cc/1IPLLYMt).

The Skywriter and the Flick are
based on the same MGC3130 3D
tracking chip. Not surprisingly,
their performance is very similar.
The chip reads up to 200 positions

last word

per second, enabling it to reliably
detect simple gestures. Like the
Skywriter, the Flick also senses
touch — in its centre and on the
four edges — so it’s a versatile input
device that could prove useful for
countless projects.

Interestingly, it even works with
the Skywriter Python library, from
which the Flick library is derived.
We were therefore able to use the
Skywriter software examples,
including a fun theremin synth.

One advantage of the Flick HAT
is the availability of optional cases
for all three models. The cases use
a non-conductive surface, which
does not interfere with the Flick’s
ability to track gestures.

The performance of the Flick HAT is very similar to that of the
Skywriter HAT, but the Flick offers an optional snug-fitting case,
as do the other Flick models. Communicating with the Pi via I*C,

the Flick only uses a small number of GPIO pins. With the ability to
detect a wide range of gestures and touches, it would be a useful
input device for many projects.
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UNICORN HATHD

Maker

says

256 RGB
LEDsina
16x16 matrix...
High-
definition
rainbow

goodness!
Pimoroni

UNICORN HAT H

Create brighter projects with the new Unicorn HAT HD

ADAFRUIT
RGB
MATRIX
HAT + RTC

This HAT makes
it easy to
control HUB75-
type LED
matrices (which
you'll need

to purchase
separately)
using a
Raspberry Pi.

£26 / $25
magpi.cc/2u9xlju
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he Pimoroni pirates have

upped their game with

this new HD version of the
classic Unicorn HAT, featuring a
16x16 array of super-bright LEDs.
Boasting four times the number of
RGB pixels of the original display,
it can do a lot more and has a real
wow factor.

The board comes pre-assembled
with its female GPIO header, so
there’s no soldering required.

All you need to do is attach the
diffuser layer to the top of the
LED array using the supplied nuts
and bolts. The diffuser makes a
big difference to the visual effect,
filling out the gaps in the display
between the rather small pixels.

Communicating with the
Raspberry Pi via SPI, the HAT uses
only four GPIO pins (plus power
and ground). Best of all, it has
its own ARM STM32F chip to do
all the heavy lifting, acting as a
middleman between the Pi and
the three LED drivers. This means

there’s no lag at all when you send
data to it, as demonstrated by the
camera program downloaded with
the one-line software installer.

The camera demo displays the
low-res live view from the Camera
Module (although it was tricky to
connect the latter to the CSI port
on a non-Zero Pi model with the
HAT sitting on top).

Other example programmes
also showcase the Unicorn HAT
HD well, particularly the snazzy
shading demo which transitions
between four classic graphics
effects to produce some awesome
eye candy. A Snake game and
Conway’s Game of Life demo
really benefit from the increased
number of pixels, confirming how
much more versatile this display is
compared with an 8x8 version.

There’s even a version of
Unicorn Paint that you interact
with via a remote web browser,
your painted pixels appearing
almost instantly on the HAT.

The Unicorn HAT HD has its
own Python library, including
functions to set the brightness
and rotation. Scrolling text across
the display isn’t as easy as using
a single function, requiring a
fairly complex loop, but you could
adapt either of the impressive
multicoloured text demos
for this purpose.

last word

The increased number of
pixels means the Unicorn
HAT HD is a more versatile
display than its predecessor.
The performance is excellent,
too, as it reacts near

instantaneously to whatever
data you throw at it. Since

the HAT's ARM chip does

all the processing, it's even
technically possible to drive
multiple displays from one Pi.
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EXAGEAR DESKTOP

Maker
Says
Run

Intel x86

applications

on ARM-
based
mini PCs
Eltechs

QEMU

QEMU is
afreeand
open-source
virtual machine
hypervisor that
allows you to
virtualise a
wide range

of operating
systems, but
you'llhave

to create

or find your
own images.

Free
qgemu.org

ELTECHS

EXAGEAR DESKTOP
FOR RASPBERRY PI 3

Run x86 programs for Linux and Windows using this virtual machine

Itechs’ ExaGear Desktop
is a virtual machine
that allows you to run

applications designed for standard
x86 processor architectures on the
Pi’s ARM CPU. It’s limited to 32-bit
(x86/1386) software, and running

a VM can’t magically increase

the Pi’s limited processor power,
but we were pleasantly surprised
by its capabilities.

We used ExaGear’s default
Debian 8 guest OS (it can also host
Ubuntu 14 and 16). This provides
instant access to a wide range of
x86 software via Debian’s standard
repositories. We were able to
quickly and easily install popular
programs including Spotify,
Dropbox and Steam, as well as
compiling software from source.

Spotify was slow to load, but
worked perfectly once it started
up, turning our Pi into a capable
streaming jukebox. The Steam
client will run, but that doesn’t
mean you'll be able to use most of
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its games and features. We installed
a few games from our collection,
including Osmose and World of
Goo, but performance on both was
sluggish and unsatisfactory. We
had better luck with classic games
from GOG.com, such as GOG’s pre-
packaged Linux x86 versions of Eye
of the Beholder and Loom.
Using Wine, we were able to
install a surprisingly wide range
of Windows software, although
we were once again limited to
32-bit programs. Turn-based
RPGs and strategy games are good
choices here, as the gameplay isn’t
particularly sensitive to lag.
Eltechs provides online guides to

setting up games including Arcanum

and Fallout. Fallout worked well,
but slowly, after we tweaked its
graphics settings. We were pleased
to find that much-loved text editor
Notepad++ also worked beautifully,
as did Microsoft Office 2003.
ExaGear is particularly handy for
old-school gaming enthusiasts, as

the Pi’s limited processor power,
graphics capabilities, and memory
are best suited to titles from the
mid-90s to mid-2000s. While
many tools for playing older games
have native Pi implementations,
ExaGear makes it easier to use
modern, legally available installers
from digital retailers like GOG and
Steam, while Wine provides support
for early Windows titles.

Helpfully, if you want to be sure
that ExaGear can run a specific
piece of software, there’s a free
three-day trial available, so you can
try before you buy.

last word

ExaGear is worth its lifetime
price if you need a specific
piece of x86 software, or

simply want the widest
possible range of applications
available to tinker with.
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BOOKS

RASPBERRY PI
BESTSELLERS

From academia to enterprise; knowledge
sharing, storage, and searching present
great challenges.

ENTERPRISE CONTENT
AND SEARCH MANAGEMENT

Author: Shailesh Kumar
Shivakumar

Publisher: Wiley

Price: £68.50

ISEN: 978-1119206811

magpi.cc/2tmAWWO

Information management for
enterprises with a business

case in mind - if they're ready to
take on Shivakumar's extensive
prescription for CMS developers,
data architects, management,
and content strategists.

NEW CHALLENGES
FOR KNOWLEDGE

Author: Renaud Fabre
Publisher: Wiley

Price: £92.50

ISBN: 978-1786300904
magpi.cc/2taGOqT

Sharing economy models are
rippling through the world

of scientific knowledge and
research; open access brings
challenges for developers,
researchers, and policy
makers - all treated here in
the context of law-making.

RELEVANT SEARCH

Authors: Doug Turnbull,
John Berryman

Publisher: Manning

Price: £27.99

ISBN: 978-1617292774

magpi.cc/2uzZx67Z

The key to successful search
delivery is relevance, and
Turnbull and Berryman have
the expertise to deliver the
results your users want.
Includes Solr, Elasticsearch,
and a useful Python example.
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CODING FOR

BEGINNERS:
USING PYTHON

Author: Louie Stowell
Publisher: Usborne
Price: £12.99

ISEN: 978-1409599340
magpi.cc/2tn6try

Those who fondly
remember the
Usborne coding books of the
1980s will be pleased to learn that
the publisher has released several
of them as free PDFs, to “celebrate
the release of Coding for Beginners:
Using Python.” The Python coding
intro itself, reviewed here, follows
the Usborne tradition, with plenty
of busy graphics and cartoon
characters that seem to keep young
learners interested while they learn
new concepts.

The basics are introduced
in a logical order. Then, after
conditionals, come flowcharts —

OAUTH 2
IN ACTION

Authors: Justin Richer,
Antonio Sanso

Publisher: Manning

Price: £27.99

ISBN: 978-1617293276

magpi.cc/2uqzWFZ

We’ve all signed

into a website with
authentication

from another common site. This
authorisation via a delegation
protocol makes the web both
easier to navigate, and more
secure. At the heart of nearly
all these logins is OAuth 2.0.
The protocol behind it, and its
extensions, has a great deal of
power and flexibility.

The sample code in the book
is a Node.js application, using
Express.js, and worked through
to emphasise the OAuth 2.0

and planning programs — which
is great to see in a book for young
learners. Before it gets too serious,
there’s an example text adventure
to type in: Castle Dragonsnax.
The game is gradually expanded
to introduce new concepts
like importing modules, and
using loops. More games and
loops follow; followed by lists
and dictionaries; then a spot of
DIY encryption.
Graphics are introduced with
the turtle module, used to draw
a snowflake. Graphical games
sidestep the usual Pygame route
in favour of Tkinter, and its canvas
model. The example minefield and
Pong-type games give learners
many of the techniques needed for
building all sorts of other games.
There’s a lot of learning crammed
into a small and easy-to-read
book: recommended.

Score

learning, without worrying about

the JS. The book is split into

sections, and after the first two

explanatory chapters, these can
be tackled in any order
as needed.

OAuth 2.0 is capable
of many uses, and
many anti-patterns
that the authors work
hard to warn against.

The warnings will help
make your site secure by
default. The advanced
chapters on tokens and
dynamic client registration are
likely to be very useful for some
Pi-based IoT projects. Readers
may also be interested in the
section on User Managed Access
(UMA), which allows users to
delegate access to each other
- useful in many federated
networks and P2P situations.

Score
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LEARNING
BLENDER

Author: Oliver Villar
Publisher: Addison Wesley
Price: £24.99

ISBN: 978-0134663463
magpi.cc/2tQIMet

Free software advocates

need make no apologies

for Blender’s interface

and capabilities — but it does
differ from other 3D rendering
software, and if you’re new

to it you’ll also benefit from a
guide. There is no better helper
than Oliver Villar, who has
spent a decade using the tool
professionally, and teaching
others; and is behind the helpful
blendtuts.com site.

By focusing on character
creation, Villar is able to cover
several key aspects of 3D work
— from pre-production, through
modelling, to shading and
animation. Villar is aiming to

FUNCTIONAL
PROGRAMMING

IN JAVA

Author: Pierre-Yves Saumont
Publisher: Manning

Price: £27.99

ISBN: 978-1617292736
magpi.cc/2vkNj6R

The emphasis here is on

functional programming

(FP), rather than on Java. Although

Java is used throughout, it’s not to

show off any recent Java ‘functional’

features — rather Saumont

demonstrates functional thinking.

He uses a technique of explaining

functional concepts, and then using

several well-chosen exercises to

help the ideas click for the reader.
The author is aware that for a

simple programming paradigm,

FP is very hard to grasp for

those steeped in imperative

programming, mutable data, and

raspberrypi.org/magpi

help professionals understand
the workflow away from their
specialist area, as well as providing
the enthusiast with all the
knowledge they need
to create something
really great.
Packed with insider
knowledge, this is
a practical book. It
features walkthroughs
of tasks, and the
specifics of Blender’s
tools (such as marking
seams on the UVs), as well as
discussing wider considerations
(such as when your mesh doesn’t
need a UV), and working with
meshes and modifiers. Tip boxes
keep you on track, and cautions
contain useful professional hints.
Exercises at the end of each chapter
involve thinking about what you’re
learning, and enhancing your
practical knowledge.

Score

changing state. Early chapters
start with simple functions, and
refactoring typical Java code. The
style is a very pure FP, which
wouldn’t be out of place in a Haskell
tutorial - but it is grounded in
practical code, such as
email validation, building
on typical Java methods.
Recursion moves from
stack-based to heap-based
functions to prevent stack
overflow, then data takes its
rightful place at the centre
of the rest of the content:
from linked lists, and advanced
list handling, to practical problem
solving with trees. Coverage of state
mutation, /O, and sharing mutable
state shows a commendable
willingness to engage the real world
that is sadly not found in all FP
tutorials. Challenging, thoughtful,
and practical.

Score

BOOKS

ESSENTIAL READING:
IT TRENDS

Whether managing IT teams, or steering
your career, there are always new subjects
to read up on.

Production-Ready Microservices

Author: Susan Fowler
Publisher: O'Reilly
Price: £31.99

ISBEN: 978-1491965979
magpi.cc/2tmHBQO

Very useful overview of splitting up

a monolithic API; written for engineers,
but presented at a management-
friendly level of abstraction.

Leaders and Innovators

Author: Tho H Nguyen
Publisher: Wiley
Price: £39.99

ISBN: 978-1119232575
magpi.cc/2tavéYu

Data management and analytics
to beat your competitors; full of
examples and case studies of big
data wins.

Getting Goosebumps

Authors: Bryan Adams, Dave Hazlehurst
Publisher: Wordscapes

Price: £12.00

ISBN: 978-0993022159
magpi.cc/2umDOgK

If digital marketing is a mystery
to you, this will help you work
out what to say to your audience,
and how to delight them.

Beginning Data Science in R

Author: Thomas Mailund
Publisher: Apress

Price: £27.99

ISBN: 978-1484226704
magpi.cc/2tn7vUx

A book of two halves: first get to grips
with the ideas of data science, then
use R to learn more deeply.

The Blockchain Alternative

Author: Kariappa Bheemaiah
Publisher: Apress

Price: £14.99

ISBN: 978-1484226735
magpi.cc/2uhzkC4

As blockchain tech revolutionises
currency, supply chains, and even
medical record-keeping, Bheemaiah
reassesses the entire financial system.
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INTERVIEW

BENCHMARKING
A RASPBERRY PI
CLUSTER

How a recent computer science convert used
the Raspberry Pi in parallel for his degree

The
cluster itself is
quite compact
- a benefit
of using four
credit-card-
sized computers

Rigoberto Moreno Delgado
Although relatively new to
computer science, Rigoberto has

recently graduated from Sonoma
State University with a bachelor's
degree in the subject.

igoberto Moreno Delgado was, like many other
college students, unsure which path to go down.

After taking a class on computer science, he
decided to pursue it as his major, and became interested
in parallel computing.

“I began my journey into parallel and high-
performance computing after my university advisor, Dr
Ali Kooshesh, mentioned that my favourite professor,
Dr Suzanne Rivoire, was teaching a course titled Parallel
Computing,” Rigoberto explains to us. “I was sceptical
about enrolling into the class since I had no idea what

parallel computing was, but I decided to take the course
and I did not regret my decision.”

He met Dr Barry Rountree, a researcher at a lab that
specialises in supercomputing, while working as an
intern at the Lawrence Livermore National Laboratory
(LLNL) over the summer of 2016.

“I'was inspired to build my own cluster so that I
could gain more experience with a distributed system,”
Rigoberto tells us. “Ialso needed a plan for my senior
research project.”

A cluster of Pis

Rigoberto was able to submit this idea as his senior
research project, and began researching. “The biggest
challenge was to find a suitable, inexpensive computer
that I could use as the nodes for my cluster. I originally
thought about purchasing old desktops and chaining
them up together to form a Beowulf cluster, but I wanted
my cluster to be portable. The best choice was to use
Raspberry Pis.”

The cluster consists of a modest four Raspberry
Pi 3s networked together. There’s also a cooling fan
connected to the makeshift chassis for the setup, and
extra heatsinks on the CPUs to help keep the system
well ventilated.

“My initial thought was that the CPU on board the
Raspberry Pi would be the biggest limiting factor to
obtaining the best performance out of the cluster,”
Rigoberto says of his experiment, “but I had high hopes
for my cluster.”

Benchmarking a cluster

Rigoberto performed two major tests on his cluster, a
Matrix Multiplication and an HPL (High-Performance
LINPACK) benchmark.

The Matrix Multiplication benchmark involves taking
two matrices of the same size and multiplying them. The
benchmark works by creating two matrices of random
numbers of a given size.
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BENCHMARKING A RASPBERRY PI CLUSTER

Below All the Raspberry Pis are powered by the
same USB hub, and connected over the network

so they can communicate with each other ) ) ) )
Matrix Multiplication tests

RUN-TIME COMPARISON

TEST:

A simple comparison of how fast
the cluster runs, versus the speed
of a single Raspberry Pi

RESULT:

The Raspberry Pi cluster was
slightly slower than the single
Raspberry Pi

SPEEDUP COMPARISON

TEST:

A comparison of how different
numbers of processes running
in parallel perform

RESULT:
The cluster is significantly worse
MPI (Message Passing Interface) is used to distribute than the Raspberry Pi on its own
evenly sized chunks of the matrices via Ethernet to every

node/process, so that they work their chunk in parallel. RIGOBERTO SAYS:
Then the results are gathered for each node/process.

This benchmark benefits heavily from parallel
execution, since the matrices can be broken down into
smaller chunks which can then be sent via Ethernet to
other nodes to be worked on in unison.

“The combined resources that the cluster has make it more powerful than
a single Raspberry Pi, but that does not make it faster with regard to the
small-scale matrix multiplication that | used. The main reason why the
cluster is not able to outperform a single Raspberry Pi is the interconnects
between the nodes. Using the on-board Ethernet (10/100 Mbps) limits how
quickly nodes/processes can communicate with each other.”

The best choice was
to use Raspberry Pis

HPL TEST

TEST:

. . A pure test of computing power
The HPL benchmark is used by the Top 500 List

(top500.0rg), which is comprised of the top 500 RESULT:
performing computer systems in the world. The
rankings are determined by how many FLOPS (floating
point operations per second) a computer can calculate.
Rigoberto was successful in earning his Computer
Science degree, with this cluster as his senior project,

3.463 GFlops

but he’s not quite done with running benchmarks on it: RIGOBERTO SAYS:

“Future work involves changing the current operating “My cluster was able to achieve a peak of 3.463 GFlops. Of course, that is
system (Raspbian Jessie Lite) to CentOS 7 and measuring nowhere close to being up to par with the systems in the Top 500 list [which can
performance differences, as well as optimising the be more than a million times faster]. As you can see from the graph, most of the
kernel to better suit the cluster. I would also like to find scores sit around 3.43 and 3.45 GFlops. The HPL benchmark greatly benefits
a method to put Gigabit Ethernet on each Raspberry Pi from having fast interconnects (Ethernet in this case). Had the Raspberry Pis

in my cluster to measure the performance gains that a had faster Ethernet speeds (preferably Gigabit), the GFlops that could be
faster interconnect would present.” obtained by the cluster would be a lot higher than they currently are.”
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FEATURE

THE MONTH IN
RASPBERRY PI

Everything else that happened this month in the world of Raspberry Pi

THE RASPBERRY PI
PC CHALLENGE

Here are some of the stories we’ve heard from you
about your experiences of using the Pias a PC

n the last issue, we ran the Raspberry Pi PC

challenge. Our Features Editor, Rob Zwetsloot,

used a Raspberry Pi as his main PC for a week.
A few readers were interested to see the results to
ascertain whether or not they could give it a try, and a
few gave us their experiences of doing the same thing.

Replacing a Mac with a Pi

Rob’s experiment, while thorough, was
conducted from the perspective of a Windows
and Linux user. Trust us: you don’t want to hear
him talk about Macs! For people who do use
Apple computers, a similar guide explaining
how one Pi user replaced their Mac for a week
with a Raspberry Pi is available online. Pierre-
Gilles Leymarie had the misfortune of losing his
MacBook in Paris, and had to come up with an
alternative. He did a great job of setting up his Pi

as a replacement, though, and you can read all
about it here: magpi.cc/2vnULhR.
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Nicholas Tate

[ use several Raspberry Pi 3s as my main
computers. For getting many of the day-to-day
tasks done, they have proven to be superior to
Mac or Windows machines. I have all kinds of
apps that work flawlessly, and would cost serious
money on PCs and Macs. The OS runs on a 500GB
SSD, which ensures that it boots and loads
programs quickly.

Annie C

My parents are using a Raspberry Pi 3 as their only
computer to browse the internet and to play some
simple games like Tetris and card games. As they
are usually not doing multiple things at the same
time, they don’t run into performance issues. I
tested their Raspberry Pi while I was setting it up,
and it was way better than I expected.

What I couldn’t solve is calls in Google Hangouts
or Skype. Regardless of the USB audio device I use
with the Raspberry Pi, the sound only works for
a few seconds, then it shuts down. When playing
videos in Chromium, it works without problems.

Chuck Dombek

I’ve used the Raspberry Pi to offload background
tasks like BOINC from my main system, as well as
to support my ventures into learning Python, and
it more than meets the challenge. I’ve even been
known to work on documents using LibreOffice if
my main system is tied up. For its cost, it does the
job quite nicely.

raspberrypi.org/magpi



JAMS

IN

PICTU.

Here are some pictures from Pi events
around the world over the last month

Egham Jam

twitter.com/EghamJam

We love the mixture of
old and new computing
here - hopefully

some of the younger
attendees will learn a
bit of history!

Milton Keynes
Raspberry Jam
twitter.com/
MKRaspberryJam

ISTE 17

iste.org

ISTE is a big
educational
conference that
concentrates

on technology.

The Raspberry Pi
North America
team were there to
demonstrate how
the Pi can be used in
computing education.

raspberrypi.org/magpi

Everyone loves a good
robot fight! Pi Noon is
a popular competition
from Pi Wars, and it
looks as if these robots
are getting some
practice in...

THIS MONTH IN PI

RASPBERRY PI
BLOG HIGHLIGHTS

Some posts from the Pi blog that caught our
eye. Visit the blog at raspberrypi.org/blog.

Ultrasonic Pi-ano

magpi.cc/2utXzNX

“At the Raspberry Pi Foundation, we love a good
music project. So of course we’re excited to
welcome Andy Grove’s ultrasonic piano to the
collection! It is a thing of beauty... and noise.
Don’t let the name fool you - this build can

do so much more than sound like a piano.”

NYC train sign: real-time train tracking
magpi.cc/2uuiyjs

“Raspberry Pis, blinking lights, and APIs — what’s
not to love? It’s really not surprising that the NYC
Train Sign caught our attention — and it doesn’t
hurt that its creators’ Instagram game is on point.”

Bicrophonic Research Institute

and the Sonic Bike

magpi.cc/2utY8ax

“The Bicrophonic Sonic Bike, created by British
sound artist Kaffe Matthews, utilises a Raspberry
Pi and GPS signals to map location data and plays
music and sound in response to the places you take
it on your cycling adventures.”

Plane spotting with Pi and Amazon Alexa
magpi.cc/2uukfoE

“Plane spotting, like train spotting, is a hobby
enjoyed by many a tech enthusiast. Nick Sypteras
has built a voice-controlled plane identifier using
a Raspberry Pi and an Amazon Echo Dot.”

August 2017 MdgPi
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GPIO ZERO 1.4

AND PINOUT

A new version of GPIO Zero is out and includes a handy diagram for novice coders

bit late to squeeze itself into the news

section for this issue, we thought this was

very much worth talking about anyway: a
brand new version of GPIO Zero is out! Version 1.4
of the Python library includes a standard selection
of improvements and optimisations, but one of the
things creator Ben Nuttall, Raspberry Pi Community
Manager, is excited about is the new pinout tool on
the command line.

“The pinout command-line tool is available to

all Raspbian users,” Ben tells us. “It shows some
information about the Pi you’re on, including an

The pinout tool
1s available to all
Raspbian users

ASCII art diagram and a pin layout for your Pi. All
Pi models since the B+ (2014) have had the same
pinout, but if you have an older model, it’ll show you
the correct pin layout for that one. It even works on
the Compute Module!”

There are some pictures on this page to illustrate
how it looks — no longer will you need to keep
referring back to a ‘Raspberry Pi gpio’ search in
Google Images. And by you, we mean us.

To get the update, run the following command in
the Terminal or on the command line:

sudo apt update && sudo apt install
python3-gpiozero

To run the new tool, you simply need to run the
command pinout -h.

Above left The tool tells you which pin relates to which
GPIO number in the code, as well as giving you other
information about your Pi

Left The ASCII art for the Pi shows the model you're
using, and even works with the smaller Pi Zero
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CROWDFUND THIS!

The best crowdfunding hits this month for you to check out...

Q.BO ONE ROBOT

magpi.cc/2vo7NT4

There have been a

few companion robot
projects on sites like
Indiegogo, but this is the
first we’ve seen that’s
powered by a Raspberry

RASPBERRY SHAKE 4D ..o vopur o
it’s nice to see a new
iteration. You’ll have to

be quick with this one

You’ve probably seen the tutorial for the original as it’s nearly finished,
Raspberry Shake on page 52, and maybe you but it has hit its funding
remember our interview with the creators in issue target. It promises

57. 1f you were excited by all that, then you might to be open-source and it
be happy to know that the latest version of the looks pretty cute too!

earthquake-detecting device, Raspberry Shake 4D, is
currently in the crowdfunding phase. It hit its goal in
just over 30 minutes and is still going strong, so this is

gt ime o bopont BEST OF THE REST

Here are some other great projects we saw this month

magpi.cc/ 2urtsXf

We love the retro styling of this radio,
and that the link will take you to the
Instructables tutorial on how to build
your own! If you look carefully you

can see an original Model B, so it will
probably work with a Pi Zero as well.

NANOSOUND ———

magpi.cc/2vu88Nr

It's been a while since we saw
a beer-brewing project using

We see a lot of Raspberry Pi DACs in crowdfunding. Raspberry Pi, and we do love the

A lot of them are pretty good, and there’s clearly idea! This link takes you to up-to-

a market for them. This one works with Kodi out date instructions on how to build the
of the box, includes an IR receiver, and even has project, so get making and create a
a built-in screen. There’s a month left in the microbrewery of your very own.

campaign, so give it a look!
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With more hands-on activities than ever, Merseyside’s maker showcase
is inspiring the next generation of creators and technologists

iverpool MakeFest’s third
year shows it to be on a
very special trajectory —
getting better every year, with no
sign of slowing down. The MakeFest
showcases the best of the Liverpool
and North West maker community,
with a few special guests from
further afield. Held over four floors
and the roof of the city’s historic
library building, it’s an exciting
blend of old and new crafts, with
plenty of hands-on activities for all
the family.

Up on the roof

On the roof, two technologies from
well before the microcomputer era
were being showcased: radio, the
original ‘wireless’; and telescopes
from the local astronomical
society. Local arts organisation
FACT brought everything up to

MdgPi August 2017

date by tuning into data from
satellites passing overhead.

Outer space continues to
inspire many people to learn about
technology, and DIY rockets were
displayed at the entrance to the
library, competing with Liverpool

RFID tag-based MileCastles, part

of the Hadrian’s Castle exhibition

taking place this summer along

the length of Hadrian’s Wall.
Crossovers between old and

new took various forms. The

Liverpool League of Gentlemen and

exa.foundation brought a full
range of Pi-based programming
and physical computing

MakeFest’s resident Dalek for
attention. VR, drones, and games
that incorporated IoT devices to
bring play into the wider world
represented the cutting edge of
present-day technology, while
artist group Domestic Science took
participants back in time with their

Extraordinary Ladies decorated the
library with their presence in full
steampunk regalia. Rachel Freire
demonstrated her mi.mu gloves,
along with a range of sensors and
feedback mechanisms incorporated
into clothing. The gloves, designed
in collaboration with singer-
songwriter Imogen Heap, are
gestural interfaces for composing
and playing music. Thermochromic
fabric was demonstrated to young
makers by Laura Pullig, an e-textile
specialist who was also showing and
selling plant-based electronics Kits.
An electronic/fabric crossover was
also found in light-up wind socks;
and an automatic knitting machine
that controls lighting, sound, and
projection by using binary values on
a punch card to create RGB colour
values. Something is also knitted as
a by-product of the process: a novel
form of documentation.

Traditional crafts were also
represented, including woodworking
and guitar making; and plenty

raspberrypi.org/magpi



of messy gluing, painting and
modelling for younger visitors.
Many of the hands-on activities
were provided by educational
institutions, including Edge Hill
University, and local educational
projects such as Bootle’s Little
Sandbox tech club for 8- to 12-year-
olds. Pi-based learning was available
in the form of Android Things,
Scratch, Python and EduBlocks (see
issue 53 of The MagPi), as well as
tiny Pi-powered robots fighting to
pop each other’s balloons in the
Micro Pi Noon activity.

The exa.foundation brought a full
range of Pi-based programming
and physical computing to the
event. Exa’s Alan O’Donohoe
(of Raspberry Jam fame) had an
interesting tale to tell: “A young
child fan of the Raspberry Pi was
telling me how great he thought
it was, just as [ spotted Peter
Lomas [designer of the Pi]. When
I introduced Pete to the young lad,
he asked me to photograph them
together. It made his day — probably
his whole weekend. The lad could
barely speak, he was that thrilled.”

Tech with a purpose

If 3D printing has begun to seem
old hat to you, consider two of the
exhibitors. MeLT-3D were making
pasta cutter dies with their printer,
along with moulds for everything
from silicone, plaster, and metal
to chocolate! Dr Laura James of
Field Ready showed some of the
3D-printed pipe fittings and
medical supplies that are saving

raspberrypi.org/magpi

LIVERPOOL MAKEFEST 2017

lives at disaster scenes across the
planet. Field Ready relies on a
worldwide network of engineers
and makers to support them with
practical modelling work and
engineering know-how.

For the full, and inspiring,
list of exhibitors, visit
magpi.cc/2uddHmO.

This year’s event saw the
organisational duties taken up
by Jen Fenner and Mark Sabino,
working with Central Library’s
Denise Jones. We asked Mark
what stuck in his memory about
this year’s event. “My personal
highlight has to be the women in
tech showcase, which saw Rachel
Freire’s first show in her home
town after 14 years’ absence
to specialise in controversial
fashion, now collaborating with
technologists on a variety of
wearables including whole-body-
interaction instruments,” he told
us. “Also, having Field Ready
and the Humanitarian Makers
demonstrating what they do in
crisis situations with 3D-printed
solutions, along with FACT tracking
the ISS, and Quantum Tech Club
exposing the sun via radio.”

Mark was also enthusiastic
about having “yet another year to
plan, to include the spectaculars
we never managed for MakeFest
2017 — which includes starting a
crowdfunding exercise to buy John
Cartwright’s Dalek, as he’s retiring
as the owner/operator.”

We look forward to Liverpool
MakeFest 2018. If you can’t wait,

there is a MakeFest at Manchester’s
Museum of Science and Industry,
19-20 August, amid the vivid
exhibits of industrial milestones
in manufacturing, flight, and
computing. If you can’t find an
event near you, get down to your
local makerspace and see what’s
planned - or get involved yourself.
There’s a generation waiting to be
inspired by your engineering and
maker skills.

August 2017 MdgPi
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PROFILE

RICHARD
HAYLER

One of the newest members of the Raspberry
Pi Foundation team is no stranger to

the community

Richard
Category: Maker

Day job: Raspberry Pi
Foundation’s
Citizen Science
Programme Manager

Website: magpi.cc/1lLmeoi
twitter.com/rdhayler

Below As an all-round maker and club
runner, Richard builds interesting
projects with his sons Jasper and Ozzy

wish Richard was my dad!”
We’ve heard this more than
once from various members
of the Raspberry Pi community.
And with Richard’s active blog
and Twitter account continuously
sharing exciting Pi-related
adventures with his sons, Jasper and
Ozzy, you can see why. From pool
noodle lightsabers to high-altitude
ballooning and International
Space Station photography, the
experimentation of Richard, his
family, and those he mentors in
Code Club and CoderDojo always
brings a smile to our faces.

More recently, Richard joined
the ranks of official Pi Towers
employees, becoming the
Foundation’s new Citizen Science
Programme Manager. The job

involves running the Oracle Weather
Station project, while thinking up
other interesting future endeavours.

An unexpected journey
Richard began his career as a
physicist, before moving on to
work in various computing and
engineering roles with the Foreign
Office. So it’s no wonder that he
was already tinkering with the likes
of the Arduino when the Raspberry
Pi came to town. As the father of
two children, Richard was keen to
increase their hands-on experience
with code and tech, so he decided to
start a Code Club at their school.
“It’s all Clare’s fault, really,”
Richard jokes when discussing how
he fell into the land of Raspberry Pi,
referring to Code Club co-founder

Below Richard'’s blog features detailed posts covering his experimentation with tech,
continued work with clubs and Jams, and shared code for his fun builds

Together with Jasper and Ozzy, Richard
created The Evolution of Raspberry Pi, a
LEGO-based journey from factory to maker,
and on to the International Space Station
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HIGHLIGHTS

CODE CLUB + DOJO + JAM

coderdojoham.org

Richard started a Code Club at his sons' school, and soon found himself deep
in the coding community. He expanded his volunteering to CoderDojo and
Raspberry Jams, and has even written a few articles for The MagPi.

Clare Sutcliffe. From Code Club,
Richard found himself taking

part in Cat Lamin’s first Coding
Evening, where he was introduced
to a CoderDojo champion - leading
him to mentor at CoderDojo Ham.
And if that wasn’t enough, he

Richard's blog posts reveal
a plethora of fun and
Interesting maker builds

also helps out at the East London
and Wimbledon Jams, mentors

a Pioneers team, and entered
PiBorg’s Formula Pi and Cam Jam’s
Pi Wars events. Richard is one of
the poster children of the Raspberry
Pi community, and we’re pretty
sure he never sleeps.

Reaching for the stars

A browse of Richard’s blog posts
reveals a plethora of fun and
interesting maker builds, each with
detailed explanations of the why and
how, delivered by a true scientist.

Among his favourite Raspberry
Pi-themed projects, Richard was
quick to highlight the work he’s
done with clubs, most notably the
primary school team he mentored
for the first Astro Pi challenge.
“To then be told that your club

is one of the two winning entries
for the Astro Pi primary school
competition is - literally - out of
this world,” explains Richard in
his blog entry of the day.
Cranmere Primary School’s
Crew Detector (code-name
‘Sweaty Astronaut’), used the
sensors of the Sense HAT,
primarily the humidity sensor,
to detect variations in the
atmosphere of the ISS and take
photographs if it detected the
presence of a crew member via
these changes. We can only

RICHARD HAYLER

Communily

magpi.cc/2u8Gvwt

HIGH-ALTITUDE
BALLOONING (HAB)
Richard attended Skycademy, a HAB-themed
programme run by the Foundation to help teachers send
a Raspberry Pi to near space. His balloon reached 35 km

before bursting, luckily landing nowhere near Heathrow
airport and the London Control Zone, both of which are
potential hazards when trying to launch so close to home.

magpi.cc/2s26Foa

KITE MAPPER

Richard and his sons created a kite mapper using a

Raspberry Pi and a newly acquired kite. Utilising the Pi
and Camera Module, they were able to collect location
and distance data alongside their images.

imagine the utter excitement of
receiving your images back from
space to find Tim Peake floating
about in front of a camera your
code was controlling.

Of his other projects, Richard
highlighted builds he’s created
with Jasper and Ozzy, both very
present in his photography and
blog entries. Yes, we’re jealous.
Yes, we want to be them. And
yes, we can’t wait to see what
Richard produces on his own,
and as part of the Raspberry Pi
Foundation team.

raspberrypi.org/magpi
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1-6 HIGHLIGHTED EVENTS 6-8 REGULAR EVENTS

BARENTS
RASPBERRY JAM
When: Saturday 5 August
Where: Pasvikveien 2,

TRACKING AIRCRAFT WITH AMSTERJAM

SOFTWARE DEFINED RADIO When: Saturday 9 September

When: Saturday 12 August Where: TQ, Amsterdam, Netherlands
Where: StarSpace 46, Oklahoma amsterjam.me

Kirkenes, Norway City, OK, USA A meet-up for Raspberry Pi
twitter.com/BarentsRJam magpi.cc/2uqipO6 enthusiasts and people who
A Raspberry Jam in northern Something slightly different: this is want to learn more about
Norway, promising to show about how Raspberry Pis are being the capabilities of the Pi in
attendees the magic of technology. used to help track aircraft in flight. all its forms.

COVENTRY FABLAB ROANOKE RASPBERRY JAM TORBAY TECH JAM
RASPBERRY JAM When: Saturday 2 September When: Saturday 12 August
When: Friday 11 August Where: Science Museum of Where: Paignton Library and
Where: Coventry FabLab, Western Virginia, Information Centre,

Coventry, UK Roanoke, VA, USA Paignton, UK
magpi.cc/2uqoFFx magpi.cc/2ugsfzp torbaytechjam.org.uk

A show-and-tell event where
people bring their amazing
Raspberry Pi projects for
others to appreciate.

A joint meeting with the
Roanoke Robotics & Makers Club
of Southwest Virginia, with an
intro to programming on the Pi.

A fun, informal and family-friendly
event that aims to inspire people,
especially children and youngsters,
to take an interest in STEM.
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WE'VE HIGHLIGHTED SOME OF
THE AREAS IN NEED OF A JAM!
CAN YOU HELP 0OUT?

Norwich, UK

Paignton, UK —

it Ul R ASPBERRY JAM ADVICE
LOCATION

School, Warranwood,
“Our local library gave us a venue free

VIC, Australia
magpi.cc/2mx2y7Y

of charge: they're just pleased that
someone is using the space.”

The group’s aim is to bring like-
minded people together to talk about
Cat Lamin
Wimbledon Raspberry Jam

how they’re using the Raspberry Pi.

RASPBERRY

JAM NORWICH

When: Sunday 20 August

Where: The Forum,
Norwich, UK

twitter.com/NorwichRJam

Bringing the fabulous

Raspberry Pi community

together at The Forum in

the heart of Norwich.

Every Raspberry Jam is entitled to apply
for a free Jam starter kit, which includes
magazines, printed worksheets, stickers,

flyers, and more: magpi.cc/2usaRdw.
Plus download your free Jam guidebook
here: magpi.cc/2q9DHfQ.
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YOUR

YOUR LETTERS

Our Essentials book will teach you all about
the Raspberry Pi Camera Module, taking you

from complete beginner to true camera pro

Digital transfers
I recently took out a digital subscription to
The MagPi, as I really enjoy your magazine and
wanted to support Raspberry Pi! I bought it on
my Android phone, though, before really giving
it any thought, and now I’d like to transfer it to
my iPad version of the app. Is there any way to
achieve this?

Also, if I get a print subscription, do you get
a digital subscription with that?
Mel S

Unfortunately, the digital purchases are tied to
your account on the individual app stores for
both Android and iOS devices, so there’s no way
to transfer between them, or buy once and use
on both. An option for a joint print and digital
subscription is something we’d love to provide.
However, the systems we use aren’t compatible
with each other, so it’s not something we
currently offer.

Do remember, though: if you decide to get
the print subscription, you can download PDF
versions of every issue of The MagPi completely
free from our website.

MdgPi August 2017

Essential cameras
Ilove the Essentials range of books that you
publish, and am very interested in the new camera
one, The Camera Module Guide. Did I miss the boat
on the print run of this, though? I have all the
other Essentials books in print, but can’t find a
way to purchase this at all.

By the way, is this the start of a new run of
Essentials books? What’s the next one going
to be on?
William

You haven’t missed a print run of the new Camera
Essentials book — we just haven’t done one yet!
The Camera Module Guide will be available to
purchase in the regular A5 pocket-size format
later this summer.

As for other Essentials books, you can definitely
expect more at some point, but we’re afraid we can’t
discuss when and what they’ll be on. Sorry! They’re
bound to be amazing, although we might be a bit
biased on that front.

GETTING THE AIY
PROJECTS VOICE KIT

We're still getting emails from a lot of people asking
how they can get their hands on issue 57 or the AlY

Projects Voice Kit that came with it. We're adding a
little boxout here to remind everyone that the kit will
be going on sale on its own soon. To find out when
the kits will be available, sign up to our mailing list at
magpi.cc/Email-me. That way, we can let you know as
soon as we have a date for the release of the kits.

raspberrypi.org/magpi
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B B8 = Bp B2

FROM THE FORUM Forum user pageauc came up with a solution: “You
could create a simple script to delete files older than
a specified number of days. Put this in a crontab to
F I L S T O R AG - run once a day, or as often as needed. Below is just an
—t e example, so edit find parameters to suit your needs...”

The Raspberry Pi Forum is a hotbed of
conversations and problem-solving for the e

community. Join in via raspberrypi.org/forums i) ARSI G eCiEs SR ST o R

have been using my Pi and Camera Module as a security Alternatively, keep the hard drive connected, and
camera. After several days, I received an error that the USB copy files to it once a day; or set a NAS drive to turn on
memory stick was full and I had to delete files to make at a certain time, then use a cron job to copy files to it.

room. Can I code for this? Can I detect that memory is nearly full
and have old files deleted automatically so the program doesn’t
come to an end? Or detect when my USB stick storage is full, then
power up an external hard drive, perform a USB stick backup to it, Have you got something you'd like to say?
then wipe the USB stick files, and power down the hard drive? Get in touch via magpi@raspberrypi.org or on The MagPi
murmuludefly section of the forum at: raspberrypi.org/forums

WRITE TO US
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PAPIRUS ZERO
SCREEN & CASE KITS

We’ve got ten PaPiRus Zero Medium (2.0-inch)

PHAT Screen and Case Kkits to give away, thanks
to Pi Supply (pi-supply.com).

PaPiRus Zero is an ePaper / elnk screen pHAT
designed for the Raspberry Pi Zero and Pi Zero W.
The PaPiRus Zero is one of the first true low-
power displays for the Pi Zero mini computer,

and uses the same ePaper technology found
in e-book readers.

Unlike a regular display, ePaper reflects light
and is capable of displaying text and images
indefinitely, without using electricity. This
makes it an incredible tool to add to Raspberry Pi
Zero projects.

You can use a PaPiRus Zero to create cool
name tags, create an ePaper watch, build a
digital sign for a store, or create an outdoor data
logging project.

Learn more about PaPiRus Zero on the Pi Supply

website (magpi.cc/20u5KTh).

For a chance to win one of these great PaPiRus

Zero pHAT Screen and Case Kkits, you just need to Ente 1‘ now at

go online and enter our competition. You could be

one of the lucky winners! magpi CC/WinAug17

Terms & Conditions

Competition closes on 31 August 2017. Prize is offered to participants world-wide aged 13 or over, except employees of the Raspberry Pi Foundation, the prize
supplier, their families or friends. Winners will be notified by email no more than 30 days after the competition closes. By entering the competition, the winner
consents to any publicity generated from the competition, in print and online. Participants agree to receive occasional newsletters from The MagPi magazine.
We don't like spam: participants’ details will remain strictly confidential and won't be shared with third parties. Prizes are non-negotiable and no cash
alternative will be offered. This promotion is in no way sponsored, endorsed or administered by, or associated with, Instagram or Facebook.

raspberrypiorg/magpi August 2017 MeigPi
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Column THE FINAL WORD

MATT RICHARDSON

Matt is Raspberry Pi's US-based product evangelist. Before
that, he was co-author of Getting Started with Raspberry Pi
and a contributing editor at Make: magazine.

¢ COMPUTER,

FULL STOP

big part of my job involves answering the
question, ‘what is a Raspberry Pi?’ Over
time, I’ve had a lot of practice responding
to it. My answer usually starts off short and direct:
“Raspberry Pi is a computer, full stop.” I’ll go on to
explain that if you plug in a microSD card, keyboard,
mouse, monitor, and power supply, it boots into a
desktop environment and you can do exactly what
you expect you can do with a computer: browse the
web, send an email, watch a video, play a game,
write a paper, or work on a spreadsheet.

I know that ‘Raspberry Pi is a computer’ might be
a really basic fact for readers of The MagPi, but it’s
a really important point to make to people who are
new to this community. A Raspberry Pi certainly
doesn’t look, and isn’t priced, like a personal
computer, so you can imagine that it sometimes
takes some gentle persuasion — or perhaps a
hands-on demo - to convince people that the
Raspberry Pi is indeed a computer, and that it works
just as they expect. I don’t blame people for being
sceptical — after all, the Raspberry Pi is a pretty
special piece of hardware.

Adaptable and affordable

It’s also a good idea to explain that there’s more
to the story. Raspberry Pi is no ordinary computer
in so many ways. For one, it’s probably the most
affordable computer, in absolute terms and pound
for pound. Additionally, Raspberry Pi’s low power
consumption, small size, and GPIO pins give it the
versatility to be used to create things beyond the

MdigPi July 2017

How do you introduce people to Raspberry Pi?
Here’s how Matt Richardson does it

capability of an ordinary personal computer. For
instance, if you wanted to make a mini rover, the
Raspberry Pi is the perfect computer to act as the
‘brains’. Imagine needing to design your rover to
carry a desktop or laptop computer; the power and
weight requirements alone would make this task
much more difficult.

It’s an important distinction about Raspberry Pi
to share with people who are new to this realm.
Yes, Raspberry Pi is a computer, but it’s not just a
computer. It’s a computer that’s also well suited to
making things. That’s probably what it’s best known
for, because month after month, this magazine is
full of amazingly clever and creative projects that
use Raspberry Pi as one of the materials. I think that
these projects are so good that they often steal the
spotlight from all the ‘everyday’ uses for Raspberry
Pi. This can lead people to forget (or never even
realise in the first place) that Raspberry Pi is first
and foremost a computer.

The best way to drive home this point is to use
the Raspberry Pi as a computer, and share your
experience with others. I certainly practise what I
preach. Whenever it’s possible, I’1l use a Raspberry
Pi to create and present my slide deck when I give
talks at events. And I use it in the office quite
a bit. In fact, this very column was written on
a Raspberry Pi 3.

With all the amazing projects you can create with
a Raspberry Pi, it can be easy to forget that it’s not
only a great computer for making, but it’s a great
computer, full stop.

raspberrypi.org/magpi
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ONLY £3.99
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CanaKit

Kit Includes:

1” Raspberry Pi
For Dummies Booklet

1 Raspberry Pi 3 Board
1 Memory Card

1~ Plastic Case

1 2.5A Power Supply
1 HDMI Cable

1~ Resistors

1 LEDs

1 Push Button Switches
1 Prototyping Breadboard
1 Jumper Wires

1 Heat Sinks

FOR

DUMMIES

Available in Europe
Available for worldwide shipping at: through RS Components

WWW.CANAKIT.COM

US DOLLARS EXCLUDING VAT

st
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